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Legal Disclaimer 

The information in this presentation is confidential and proprietary to SAP SE or an 
SAP affiliate company and may not be disclosed without the permission of SAP SE or 
the respective SAP affiliate company. This presentation is not subject to your license 
agreement or any other service or subscription agreement with SAP SE or its 
affiliated companies. SAP SE and its affiliated companies have no obligation to 
pursue any course of business outlined in this document or any related presentation, 
or to develop or release any functionality mentioned therein. This document, or any 

related presentation and SAP SE or an SAP affiliate company’s strategy and possible 
future developments, products and or platforms directions and functionality are all 
subject to change and may be changed by SAP SE and its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise or legal obligation to deliver any material, code or 
functionality. This document is provided without a warranty of any kind, either 
express or implied, including but not limited to, the implied warranties of 

merchantability, fitness for a particular purpose, or non-infringement. This document 
is for informational purposes and may not be incorporated into a contract. SAP SE 
and its affiliated companies assume no responsibility for errors or omissions in this 
document, except if such damages were caused by SAP SE or an SAP affiliate 
company’s willful misconduct or gross negligence.  

All forward-looking statements are subject to various risks and uncertainties that 
could cause actual results to differ materially from expectations. Readers are 
cautioned not to place undue reliance on these forward-looking statements, which 
speak only as of their dates, and they should not be relied upon in making 
purchasing decisions. 
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Release Notes 

This document contains the release notes for the Concur Invoice functionality for the 

professional edition. 

Concur Invoice 

**Reminder** New User Interface for Concur Invoice Available for 
Client Review and Opt-In  

Overview 

Clients still have the opportunity to familiarize themselves with the new user 
interface as SAP Concur prepares for general availability targeting the first quarter in 

2019.  

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 

Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 
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 For more information, refer to the New User Experience for Concur Invoice 
Client Fact Sheet and the **Planned Changes** New User Interface for 
Concur Invoice Soon Available release note in this document. 

File Transfer Authentication 

Security Update to File Transfer Authentication 

Overview 

SAP Concur will update an authentication setting for clients who transfer files to/from 
SAP Concur, targeting January 16, 2019. The updated setting will lock out user 

accounts after five failed authentication attempts. Some accounts are already using 
this setting. This change will update all accounts to this setting.  

This authentication change does not impact the main SAP Concur application login, 
only the file transfer process is affected.  

The affected URLs are:  

• st.concursolutions.com  

• st-eu.concursolutions.com 

• st-cge.concursolutions.com 
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Clients who have been locked out of their accounts can contact SAP Concur support 
to unlock their accounts.   

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides better security for clients when accessing extract and import 
files.  

Configuration / Feature Activation 

This change will be implemented automatically. 

SAP Concur Email 

**Ongoing** Email Infrastructure Change - Add IP Addresses to 

Safe Senders List 

Overview 

SAP Concur is transitioning to a new email infrastructure for outbound email from 
our services to SAP Concur users. Because of this, companies that filter inbound 

email based on the sending IP address must add new IP addresses to their Safe 
Senders list to ensure that their users receive email from SAP Concur. 

IMPORTANT: All Services Will Soon Be Affected 

Initially, the issue described here affected only companies that use Concur Expense. 
Starting in January, email from other SAP Concur services (such as Concur Travel 

and Concur Pay) will move to the new email infrastructure.  

We will continue to add other services throughout the first quarter of 2019. Please 
monitor the release notes for more information about the timing of the additional 
changes. 

NOTE: This change affects only companies that filter incoming email based on IP 
addresses. 

Configuration / Feature Activation 

The new IP addresses are not published publicly but they are available by contacting 

SAP Concur support. If your company uses Concur Expense and if your company 
filters incoming email based on IP address, please work with your email server 
management team to ensure that all required IP address Safe Senders lists are 
updated so that your users continue to receive SAP Concur email without 
interruption. 
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**Ongoing** Updated Email Format  

Overview 

SAP Concur is in the process of updating the format of all email notifications. These 
changes will provide a fresher, consistent look-and-feel across all SAP Concur 
services.  

BUSINESS PURPOSE / CLIENT BENEFIT 

The intent is to provide a consistent, updated look for users. 

IMPORTANT 

Note the following: 

• The email content has not changed – just the look and feel. 

• The changes will appear over time. Each product team (Expense, Invoice, 
Travel, etc.) decides when to use the new format. Timing will be based on 
resource availability and the priority of other scheduled enhancements.  

• Do not expect that all product emails will change at the same time. For 
example, perhaps Concur Expense approval email will be first, and then other 
Concur Expense notifications will follow.  

• There is no assigned end date to the project. Expect that the changes may 
take longer than a year. 

• Each team will provide release notes when their new emails are scheduled to 
appear. 

What the User Sees 

The Concur Expense approval email is shown below. Over time, all emails generated 
from SAP Concur will have a similar look. 
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New Format 

 

Current Format 

 

Configuration / Feature Activation 

This change will occur, over time, automatically; there are no additional 
configuration or activation steps. 
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Planned Changes 

The items in this section are targeted for future releases. SAP Concur reserves the 

right to postpone implementation of – or completely remove – any 
enhancement/change mentioned here. 

Concur Invoice 

**Planned Changes** New User Interface for Concur Invoice 

Targeted for March Release 

Overview 

SAP Concur will soon offer a new user experience that is particularly targeted at the 

Accounts Payable (AP) user who is constantly monitoring the health of the Invoice 
lifecycle within the system. With a new AP landing page, concepts of "call to action" 
and "work to zero" are being brought to the forefront to better inform AP users to 
ensure they are working on the highest priority task. 

The new user interface in Concur Invoice that clients can now review and familiarize 
themselves with is targeted for general availability the first quarter in 2019.  

NOTE: Contact your SAP Concur representative for more information about the Early 

Access program. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 

What the Invoice AP User and Invoice Processor See 

The Invoice AP User and the Invoice Processor will now land on a new Invoice 
Manager page that provides key information about all active invoices. 

On the Invoice Manager tab, the Invoice AP User and Invoice Processor see new 
tiles and new sections including visibility into Active Invoices and My Tasks 
sections. 
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The Invoice Processor also sees a newly designed Unassigned Invoices page that 
is more modern and aligns with Next Gen UI initiatives across the SAP Concur Spend 
platform. 

 

What the Invoice User Sees 

Invoice users who have access to My Requests, will see a newly designed My 
Invoices page that is more modern and aligns with Next Gen UI initiatives across 
the SAP Concur Spend platform. 

 

Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 
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NOTE: More information about the new Concur Invoice user interface will be made 
available in future release notes. 

**Planned Changes** Payment Request(s) Renamed to Invoice(s) 

Overview 

In a future release, SAP Concur will replace instances of the term "payment request" 
and its iterations with the term "invoice" and its iterations. These changes will be 
made in the user interface, the Concur Invoice documentation, and in all other SAP 
Concur product documentation where it appears. 

NOTE: This term change is targeted for the March release. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change helps to ensure that the terminology used in SAP Concur is consistent 
with industry standard terminology. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 
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Invoice E-Bunsho Timestamp 

**Planned Changes** Updated Invoice E-Bunsho Timestamp Icon 

Overview 

The icon for the Invoice e-Bunsho Timestamp feature will be updated from an analog 

clock symbol ( ) to a check mark symbol ( ). 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change improves the usability of the feature. 

What the User Sees 

When the user views a list of their invoices on the Invoice > My Requests > 
Payment Request List page, if an invoice in the list includes a successfully 
timestamped invoice image, the e-Bunsho timestamp icon appears below the date in 
the Invoice Date column for that invoice. 

Configuration / Feature Activation 

The update is automatically available; there are no additional configuration or 
activation steps. 

Purchase Order 

**Planned Changes** Import Now for PO and PO Receipt Imports 

Overview 

The Import Now feature enables clients to import PO and PO receipt files into Concur 
Invoice immediately without having to wait for an overnight scheduled import. This is 
beneficial for clients who need to import POs and PO receipts and work with them in 
the Concur Invoice product the same day they are created externally. This also 
allows clients to do multiple PO and PO receipt imports a day for more synchronized 
and up-to-date data. 

NOTE: The Import Now feature is currently in an Early Adopter program. For more 
information, contact your SAP Concur representative. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature gives clients control over when and how frequently to import POs and 
PO receipts into Concur Invoice. 
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Configuration / Feature Activation 

This enhancement is automatically available. To start using this feature, clients need 
to add the suffix "importnow" on their PO and PO receipt files that are transferred to 

their FTP site. 

Current Import Naming Convention 

The current naming conventions are as follows:  

• PO import: poinvoice_EntityID_Date 

• PO Receipt Import: purch_receipt_EntityID_Date 

These naming conventions will remain as is today and the files will continue to be 
picked up and run on the existing schedule. Clients who wish to always import these 
records using the import now option should adjust their schedules accordingly and 

remove any scheduled jobs from the purchase order and purchase order receipt 
import job definitions. 

Import Now Naming Convention 

The Import Now naming conventions are as follows:  

• PO Import: poinvoiceimportnow_EntityID_Date 

• PO Receipt Import: purch_receiptimportnow_EntityID_Date 

For the Import Now option, the PO receipt file is usually dependent on the PO file, so 
clients need to coordinate their file transfer to the FTP site so that the PO file is 
always transferred first before the PO receipt file to ensure the PO’s are imported 
before the receipts. The PO receipt Import Now function will not start until any active 
PO import running is completed. However, once the PO files are sent with the 
"importnow" suffix, they will be imported immediately when they are transferred to 
the FTP site. 

NOTE: Clients must have an FTP site to use this feature. 

Vendor Management 

**Planned Changes** Audit Trail for Vendor Changes 

Overview 

In a future release, clients with the Create and Approve Vendors feature enabled will 
be able to track changes to a vendor through the Audit Trail page within the vendor 
record in Vendor Manager. For example, when a vendor is approved or updated by 
the Vendor Manager, those actions will appear on the Audit Trail page.  



Planned Changes 

SAP Concur Release Notes Page 12 Invoice Professional/Premium 
Release Date: January 12, 2019  SAP Concur Client FINAL 
Update #1: Friday, January 14, 1:00 PM PST 
 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will enable users with the Invoice Vendor Manager role to track changes 
made to vendor information in Vendor Manager. 

What the Invoice Vendor Manager Sees 

Within an open vendor record, in the Actions menu, the vendor manager will see a 
new option, View Audit Trail. 
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After clicking the View Audit Trail option, the audit trail page for the vendor will 
appear. 

 

Configuration / Feature Activation 

This feature is automatically available; there are no additional configuration or 
activation steps. 

**Planned Changes** Create and Approve Vendors Available in 

Test Environments 

Overview 

In a future release, the Create and Approve Vendors Feature will be available in test 
environments.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change enables developers and implementation teams to work with the Create 
and Approve Vendors feature prior to moving to a production environment. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 
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**Planned Changes** Support for Multi-Level Connected Lists With 

Create and Approve Vendor 

Overview 

In a future release, on entities with the Create and Approve Vendors feature 
enabled, the vendor information form will support the use of multi-level connected 
lists. 

NOTE: The Create and Approve Vendors feature is enabled by default on standard 

entities and disabled by default on professional entities. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature will enable the Invoice Configuration Administrator to customize the 
vendor information form with multi-level list fields.  

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

Budget 

**Planned Changes** Workflows for Budget 

Overview 

In a future release, workflows will be available for Budget. Workflows define how the 
system routes invoices, expense reports, and requests through approval and 
processing steps. The flexible workflow feature for Budget that SAP Concur offers 
allows companies to design workflows specifically tailored to their unique needs.   

Without budget review, budgets may become fully consumed well before the end of a 
period or year leaving an organization with limited options and budget owners with, 
for example, exceeded budgets. In addition, early spending means that more 
important (to the organization) spending will be declined because lesser important 
spending consumed the budget early on.  

Combining budget review in the workflow adds value. Audit rules and workflow step 
rules can help organizations to add in controls when it makes sense to fine tune to 

an organization's specific needs.  

Equally important is the determination when a spending item is regarded as 
committed toward a budget. In most organizations, the commit is when a spending 
item is paid; it went through most if not all approval steps. In other organizations, 
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the commit occurs much earlier. As soon as a purchase request or an authorization 
request is approved it is regarded as "promised".   

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature will provide clients with control over the budget spend to, for example, 
avoid exceeded budgets too early in a budget period or budget year.   

Configuration / Feature Activation 

The administrator needs to configure this feature on the Workflows page by clicking 

Administration > Invoice or Expense. 

Company Administration 

**Planned Changes** Single Sign-On (SSO) Self-Service Option 

Coming to SAP Concur 

Overview 

Single Sign-On allows users to access multiple applications using one set of login 

credentials. Currently, SAP Concur has two methods for signing in: with a user name 
and password or using SSO with identity provider (IdP) credentials, such as a user's 
login credentials for their organization. 

SAP Concur is planning to add a Manage Single Sign-On (SSO) feature to SAP Concur 
which provides SAP Concur clients with a self-service option for setting up SSO for 
their organization. SSO is currently supported for Concur Expense, Concur Invoice, 

Concur Request, and Concur Travel. 

Other SAP Concur products and services are outside the scope of this initial release. 

The new Manage Single Sign-On (SSO) feature will be accessible from the 
Administration > Company > Company Admin page. 

NOTE: This new feature does not affect Concur Travel clients who are already using 
the Security Keys feature. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides SAP Concur clients with a self-service option for setting up 
SSO. 

Configuration / Feature Activation 

Configuration information will be coming in a future release note. 
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Training Administration  

**Planned Changes** Optimizing and Relocating the Page 

Overview 

To simplify the Training Administration page, the functionality and content will be 
changing. 

In addition to content changes, access to the Training Administration page will 
move from Company Admin to Tools. 

BUSINESS PURPOSE / CLIENT BENEFIT 

These changes will make the Training Administration feature easier to find and use. 

Configuration / Feature Activation 

The changes will be automatically available; additional information about potential 
configuration or activation steps will be provided in a later version of these release 
notes. 

 For general information about the Training Administration feature, refer to 
the Shared: Training Administration Setup Guide. 

Test User Admin 

**Planned Changes** Retiring the Purge Test User Transactions 

Functionality 

Overview 

SAP Concur is retiring the functionality in the Test User Admin feature that removes 

the transactions of test users from Concur Expense, Concur Invoice, Concur Travel, 
and Concur Request.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will allow SAP Concur to devote more resources to development and 
maintenance of features that are used by many or most of our clients. 

What the Admin Sees  

The Test User Admin page will no longer display the Purge Test User 
Transactions button. 
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Before 

 

NOTE: To access the page, click Administration > Expense (or Invoice or 
Requests) > Test User Admin. 

After 

  

Configuration / Feature Activation 

The functionality will automatically be removed. 

 For general information about the Test User Admin feature, refer to 
the Shared: Test User Setup Guide. 

SAP Concur 

**Planned Changes** New SAP Concur Sign In Page 

Overview 

SAP Concur is planning to add a new Sign In page, providing an updated login 
experience for users who log in with user name and password credentials. Current 
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Single Sign-On (SSO) users will log in without having to enter additional credentials. 
This feature is planned for 2019. 

The new Sign In page feature includes the following: 

• Two-step login: provides enhanced security, meets current industry 
standards, and provides a better log in success rate 

• Multi-account login: allows administrators to log in with multiple accounts 

• Password hint removal: provides better security for users and SAP Concur 

• User avatar: enhances the user experience (planned for a future release) 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides better security and a faster, more convenient experience for 
users logging in to SAP Concur products and services. 

What the User Sees – Current Sign In Page 

The SAP Concur Sign In page currently appears with User Name and Password 
fields, and a Sign In button. Once a user is authenticated, the SAP Concur Home 
page appears. 
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What the User Sees – New Sign In Page 

The new SAP Concur Sign In page will have an Email or Username field and a 
Continue button. The user will type in their email or username. The user can select 

the Remember me on this computer check box, so their email or username is 
stored and will not have to be reentered the next time they log in to SAP Concur.  

After entering their email or username, the user will then click Continue. 

 

Depending on the client’s implementation of SAP Concur, users will then be directed 
to the designated Identity Provider (IdP) Single Sign-On portal or an additional Sign 

In page. 
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SSO USERS 

When the designated Identity Provider (IdP) Single Sign-On portal appears (similar 
to the one shown below), the user will enter their email or username, and their 

password, and then click Sign In. After being authenticated, the user will be 
directed to the SAP Concur Home page. 

 

After being authenticated, the user will be directed to the SAP Concur Home page. 
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USERS WITH USERNAMES AND PASSWORDS 

The user will be directed to an additional Sign In page. The user will enter a 
password and click Sign In. The system will then authenticate the user's credentials. 

 

Once the user’s password is verified, the SAP Concur Home page appears. 

RETURN USERS 

If a returning user selected the Remember me on this computer check box during 
their initial login session, they will see their email or user name displayed on the 
Sign In page. Users who did not select the Remember me on this computer 
check box will log in as they did initially. 
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The user will click on their username, and then and then one of the following occurs: 

• SSO Users: The user will be directed to the SAP Concur Home page. 

• Users with Usernames and Passwords: On the Sign In page, the user 

will enter a password and then click Sign In. The user will then be directed to 
the SAP Concur Home page. 

USERS WITH MULTIPLE ACCOUNTS 

SAP Concur users with multiple login accounts have more than one login option 
depending on the user role or account they want to use. The user will first log in to 

SAP Concur using one of their accounts. Once successfully logged in, the user logs 
out of the system. 

To add another account, on the Sign In page, the user clicks the Use Another 
Account link. 

 

The next login step depends on the account type the user wishes to use: 

• SSO Account: If the user selects an account with SSO credentials, the user 
will enter an email, then the user will be directed to the IdP Single Sign-On 

portal. Once the user is authenticated, the SAP Concur Home page appears. 

• Username and Password: The user is directed to an additional Sign In 
page to enter a password. The user then clicks Sign In. Once the user is 
authenticated, the SAP Concur Home page appears. 
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When all of the accounts have been added, a return user will select the account they 
want to use to log in to SAP Concur. 

 

FORGOT USER NAME 

If a user forgets their user name, the user will click the Forgot username? link on 
the Sign In page.  
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Next, the Forgot User Name page appears. On the Forgot User Name page, the 
user will enter their email and click Send to have an email sent to a verified email 
account. The email will contain their user name. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 

 



Planned Changes 

SAP Concur Release Notes Page 26 Invoice Professional/Premium 
Release Date: January 12, 2019  SAP Concur Client FINAL 
Update #1: Friday, January 14, 1:00 PM PST 
 

INVALID PASSWORD 

If a user forgets their password, an on-screen message will appear alerting the user. 
The user will then click Send to have a password reset email sent to their verified 

email account. 

SAP Concur compares the email address entered by the user to the email address in 
the user's SAP Concur profile. If the email addresses match, then SAP Concur 
generates a one-time sign-in token (link) that can be used for one hour. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 

 

Configuration / Feature Activation 

Configuration information will be provided in a future release note. 

Miscellaneous 

**Planned Changes** Archive Deactivated User Data 

Overview 

As SAP Concur continues to grow, steps must be taken to enhance and improve the 

performance of our system so that we can meet customer expectations and the 
needs of their business. 

Our overall goal is to significantly improve the performance of SAP Concur services 
by reducing the amount of data that is stored in our Production datastore. By 
reducing the data in the Production system, we can use server memory much more 
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efficiently, which reduces processing time for transactions. For this reason, SAP 
Concur is developing an archive process for users who have been deactivated by 
their employers for at least three years. The archive process moves this 
"deactivated" user data from our Production datastore to a separate Reporting 
datastore. 

NOTE: The Reporting datastore contains data that is not tied to active expense 
reports or travel itineraries. The information in the Reporting datastore is still 
available for reporting in Concur Intelligence, but it is not readily available 
from the SAP Concur application itself. 

BUSINESS PURPOSE / CLIENT BENEFIT 

Moving deactivated user data will provide faster processing time for transactions. In 
addition, it provides a more secure environment for inactive user's personal 
information. 

IMPORTANT!  

We are currently piloting the process and evaluating the results. Our goal is to 
ensure that customers are not negatively affected, that we have considered all 
pertinent scenarios, and that the archiving process provides the desired results.  

There is no targeted date for the implementation of this new process. We will 

announce via release notes well ahead of time. 

Additional Information in Future Release Notes 

This release note provides basic, general information about the process. Greater 
detail – for example, about reactivating an archived user, user imports, and admin 
functions – will be provided in future release notes. 

What the User Sees  

This change will provide faster processing times and greater stability of the system. 

FAQ 

Q. How often will SAP Concur archive deactivated user data?  

A. SAP Concur intends to archive deactivated user information on a 
reoccurring basis, similar to how we perform other system tuning tasks. 
Whether the archive process runs nightly, weekly, or on some other 
frequency will be adjusted to ensure that we obtain the benefits of the data 
archiving without impacting system performance. 
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Q. The current policy of SAP Concur move to the Reporting datastore? 

A. The current policy of SAP Concur will be to move – from Production to 
Reporting – the user profile information for any user who has had their access 

to SAP Concur services revoked by their employer – in other words – they 
have been "marked inactive" in the SAP Concur system. A user must be 
deactivated for over 3 years without having been re-activated to be a 
candidate for archival.  

Q. What impacts, if any, will I see in my Production system when a user is moved to 
the Reporting datastore? 

A. For Professional Edition, the most significant difference would occur in 
Company Admin > User Administration.  

However, once user information is archived: 

 From within User Administration, if the Use Travel Advanced Filters 

option is chosen, the user will not be visible. 

 From within User Administration, if the Use Expense Advanced Filters 
option is chosen, you will be able to see the user in search results as 
deactivated.   

• If you click the user's name, you will receive an error message: 
The selected user exists in the Concur Expense or Concur Invoice 

application, but the user contains conflicting or missing data. 
Contact SAP Concur support to request help in resolving this error. 

• If you click the icon in the Profile column, you will receive the 
generic error message.  

• If you click the user's login ID, you will see no historical login 
information for that user. 

 If another user has the Self-Assigning Assistant permission or the user is a 
Proxy who can act on behalf of a user in an assigned group and searches 
for the archived user, the archived user will appear as inactive. If the 
other user tries to act on behalf of the archived user, the employee will 
receive an "switching user" error message. 

 From within Concur Travel administration, the user will not be searchable 
from User Administration. For within Concur Expense or Concur Invoice 
administration, the user will still be visible when viewing inactive users. 
Concur Expense and Invoice administration source user data from the 
Concur Expense entity datastores, which are not currently subject to the 
SAP Concur Archival process. 

For Standard Edition, locate users via Administration > Expense Settings 
> Users or Administration > Travel Settings > Manage Users, 
whichever applies. 
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Q. What do I do if an employee leaves my company for over three years, and then 
returns? 

A. SAP Concur plans to provide a user interface that a company's User 

Administrator can use to reactivate the user. 

 These users will not have access to any of their past travel history.  

 For Concur Expense, the user would have access to their expense history 
if: 

• That history has not been removed by a Data Retention policy. 

• The HR Employee ID for the user is the same as when they were 
last active in the SAP Concur System. 

If either of these circumstances do not apply, then the user would not have 
access to their previous expense reports or other Concur Expense data. 

 Q. Will Data Retention features work on archived users?   

A. Yes. Regardless of where the user data is located – in the Production 
datastore or the Reporting datastore – user data will be obfuscated as per the 
requirements defined in the Data Retention feature. 

Q. Once a user has been archived, is there any way to restore that user? 

A. SAP Concur is looking into ways to help administrators re-activate their 
users without opening a support case. 

Q. After a user's information has been archived, will we be able to view the user's 
expense reports and receipts online within Concur Expense? 

A. Yes. Processors will be able to search for expense reports from archived 

users. They can search by Report ID or Employee Name and can view all 
receipts from within Concur Expense once they have selected an expense 
report.   

Please note that you will not be able to use the Proxy feature to see a former 
employee's expense report. You will see an error message should you 
attempt this. 

Q. After a user's information has been archived, will an approver be able to see the 
archived user's expense reports that this approver approved in the past? 

A. Yes, if an approver clicks Approvals > Reports and then clicks View > 
All Reports you Approved, then these expense reports will be visible. 
Approvers will be able to view the receipts for those expense reports. 

Configuration / Feature Activation 

The change will occur automatically; there are no additional configuration or 
activation steps. 
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Client Notifications 

Subprocessors 

SAP Concur Non-Affiliated Subprocessors 

The list of non-affiliated subprocessors is available here: SAP Concur list of 
Subprocessors 

If you have questions or comments, please reach out to: Privacy-
Request@Concur.com  

Browser Certifications 

Monthly Browser Certifications and Supported Configurations 

The SAP Concur Release Notes – Monthly Browser Certifications document lists 
current and planned browser certifications. The document is available with the other 
SAP Concur monthly release notes. 

 For information about accessing all release notes, browser certifications, 
setup guides, user guides, other technical documentation, and supported 
configurations, refer to the Additional Release Notes and Other Technical 
Documentation section in this document. 

https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
mailto:Privacy-Request@Concur.com
mailto:Privacy-Request@Concur.com
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SAP Concur Support Case Status 

This release might resolve previously submitted support cases. You can check the 

status of a support case to confirm whether the case issue has been resolved. 

Check Support Case Status 

The steps in this procedure provide instructions for checking whether a case is 
resolved. 

 To check the status of a submitted case: 

1. Log on to https://concursolutions.com/portal.asp. 

2. Click Help > Contact Support.      

 

The SAP Concur support page displays. 

 

https://concursolutions.com/portal.asp
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NOTE: If the Contact Support option is not available in the Help menu, then 
your company has chosen to support the SAP Concur system 
internally. Please contact your internal support desk for assistance. 

3. In the Quick Search field, enter your Case ID. 

4. Click Search. Search results are limited to each company's own cases. 

January Example 

The table below contains some example cases that are resolved in this release. It is 
not a comprehensive list of the resolved cases. 

 

Case ID Description 

13010733 

12996888 

Invoice Processor 

Processors are unable to approve invoices with cost object approval due to 
missing Approve button. 

12955254 

Concur Invoice 

The Unit Price on the line item level returns to zero if there are more than 
four digits on it while adding line items and moving to a different tab. 

12371248 

Audit Rules 

When the Processor modifies the header, the audit rule check Amount 
Remaining to be itemized is not fired. 

12605645 

Capture Processing 

Invoice Capture with VAT amount 1 - 4 triggers audit rule error that prevents 
auto submit. 
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Additional Release Notes and Other Technical 
Documentation 

Online Help – Admins 

A user who is assigned an admin role can access release notes, setup guides, user 
guides, admin summaries, monthly browser certifications, supported configurations, 
and other resources through Invoice Administration Help. 
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SAP Concur Support Portal – Selected Users 

Users who are assigned the correct SAP Concur support portal permissions can 
access release notes, setup guides, user guides, admin summaries, monthly browser 

certifications, supported configurations, and other resources through the SAP Concur 
support portal. 

 To access the SAP Concur support portal (for users with the correct 
permissions): 

1. Click Help > Contact Support.  

2. On the support page, click Resources > Release/Tech Info. 
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© 2019 SAP SE or an SAP affiliate company. All rights 
reserved. 

No part of this publication may be reproduced or transmitted in any form or for any 
purpose without the express permission of SAP SE or an SAP affiliate company.  

SAP and other SAP products and services mentioned herein as well as their 
respective logos are trademarks or registered trademarks of SAP SE (or an SAP 
affiliate company) in Germany and other countries. Please see 

http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional 
trademark information and notices.  

Some software products marketed by SAP SE and its distributors contain proprietary 
software components of other software vendors.  

National product specifications may vary.  

These materials are provided by SAP SE or an SAP affiliate company for 
informational purposes only, without representation or warranty of any kind, and 
SAP SE or its affiliated companies shall not be liable for errors or omissions with 
respect to the materials. The only warranties for SAP SE or SAP affiliate company 
products and services are those that are set forth in the express warranty 
statements accompanying such products and services, if any. Nothing herein should 

be construed as constituting an additional warranty.  

In particular, SAP SE or its affiliated companies have no obligation to pursue any 
course of business outlined in this document or any related presentation, or to 
develop or release any functionality mentioned therein. This document, or any 
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible 
future developments, products, and/or platform directions and functionality are all 

subject to change and may be changed by SAP SE or its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise, or legal obligation to deliver any material, code, or 
functionality. All forward-looking statements are subject to various risks and 
uncertainties that could cause actual results to differ materially from expectations. 
Readers are cautioned not to place undue reliance on these forward-looking 

statements, which speak only as of their dates, and they should not be relied upon in 
making purchasing decisions. 
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Legal Disclaimer 
The information in this presentation is confidential and proprietary to SAP SE or an 
SAP affiliate company and may not be disclosed without the permission of SAP SE or 
the respective SAP affiliate company. This presentation is not subject to your license 
agreement or any other service or subscription agreement with SAP SE or its 
affiliated companies. SAP SE and its affiliated companies have no obligation to 
pursue any course of business outlined in this document or any related presentation, 
or to develop or release any functionality mentioned therein. This document, or any 
related presentation and SAP SE or an SAP affiliate company’s strategy and possible 
future developments, products and or platforms directions and functionality are all 
subject to change and may be changed by SAP SE and its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise or legal obligation to deliver any material, code or 
functionality. This document is provided without a warranty of any kind, either 
express or implied, including but not limited to, the implied warranties of 
merchantability, fitness for a particular purpose, or non-infringement. This document 
is for informational purposes and may not be incorporated into a contract. SAP SE 
and its affiliated companies assume no responsibility for errors or omissions in this 
document, except if such damages were caused by SAP SE or an SAP affiliate 
company’s willful misconduct or gross negligence.  

All forward-looking statements are subject to various risks and uncertainties that 
could cause actual results to differ materially from expectations. Readers are 
cautioned not to place undue reliance on these forward-looking statements, which 
speak only as of their dates, and they should not be relied upon in making 
purchasing decisions. 
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Release Notes 
This document contains the release notes for Concur Invoice functionality for 
professional edition. 

Concur Invoice 

Menu Changes to Invoice Pay and Invoice Capture Features 

Overview 

Several design changes have been implemented in Concur Invoice. The Services 
menu has been removed, a new menu named Payments has been added, and the 
Invoice Capture and Payment Manager options have been moved to new 
locations.  

NOTE: The Invoice Capture option is only available to clients with the Invoice 
Capture feature enabled. The Payments menu is only available to users with 
the Invoice Payment Manager role. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This enhancement makes it easier for clients to navigate to the Invoice Capture, 
Payment Manager, and Provider Payment Manager features. 

What the User sees 

Users with access to the Invoice Capture feature will see the Invoice Capture 
option immediately after clicking Invoice. 

Before 

 

After 
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Users with the Invoice Payment Manager role will see a new menu named Payments 
and will see the Payment Manager and the Provider Payment Manager options 
in the Payments menu. 

Before 

 

After 

 

Configuration / Feature Activation  

This change is automatically available; there are no additional configuration or 
activation steps. 

**Reminder** New User Interface for Concur Invoice Accounts 
Payable Available for Client Review and Opt-In  

Overview 

Clients still have the opportunity to familiarize themselves with the new user 
interface as SAP Concur prepares for general availability targeting the second quarter 
in 2019.  

NOTE: For clients reviewing this feature, SAP Concur has now added an 
Unapproved Vendor link in the Back Office section of the Invoice 
Manager page. More information is available in the referenced fact sheet at 
the end of this release note. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 
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Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 

 

 For more information, refer to the Concur Invoice Accounts Payable User 
Experience Enhancement Client Fact Sheet and the **Planned Changes** 
New User Interface for Concur Invoice Soon Available release note in this 
document. 

Invoice Pay 

New Provider Payment Manager Feature 

Overview 

With the February release, Invoice Pay clients who have signed up with a payment 
provider on the App Center will be able to use the new Provider Payment Manager 
feature. 

The Provider Payment Manager feature offers clients, who use external payment 
providers, the option to view details and status of their payments in SAP Concur 
without having to log into their providers' systems.  
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NOTE: Clients must have the Invoice Payment Manager role to use this feature. 

NOTE: Clients must also have a contract with a payment provider on the App Center, 
which is a purchased service. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The Provider Payment Manager feature makes it easier for clients to keep track of 
their payments when their payments are processed by a third-party payment 
provider. 

What the Payment Manager Sees 

The user with the Invoice Payment Manager role will see a new menu, Payments, 
with a new option, Provider Payment Manager. 

 

When the user selects the Provider Payment Manager option, they will see a new 
page, Provider Payment Summary. 

 

Configuration / Feature Activation  

To use the Provider Payment Manager feature, clients must sign up with a payment 
provider on the App Center. 

 For more information, refer to the Invoice: Invoice Pay User Guide and the 
Invoice: Payment Confirmation Extract Specification. 



Release Notes 

SAP Concur Release Notes Page 6 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

Invoice Capture 

Verification Page Changes for Large Documents 

Overview 

In previous releases of Invoice Capture, when uploaded batches containing 
documents with more than 500 pages were viewed on the Invoice Capture 
Verification page, clients could view every page in each document. 

Beginning in this release, if a document has more than 500 pages, the first page will 
be displayed on the Verification page. To view all pages in a document, you can 
download the document in PDF format.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change improves the performance of the Verification page. 

Configuration / Feature Activation 

This change is automatically available. 

Vendor Management 

Audit Trail for Vendor Changes (Released February 22) 

Overview 

Clients with the Create and Approve Vendors feature enabled can now track changes 
to a vendor through the Audit Trail page within the vendor record in Vendor 
Manager. For example, when a vendor is approved or updated by the Vendor 
Manager, those actions appear on the Audit Trail page.  

NOTE: The Create and Approve Vendors feature is disabled by default on Professional 
entities. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change enables users with the Invoice Vendor Manager role to track changes 
made to vendor information in Vendor Manager. 
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What the Vendor Manager Sees 

Within an open vendor record, in the Actions menu, the Vendor Manager will see a 
new option, View Audit Trail. 

 

After clicking View Audit Trail, the audit trail page for the selected vendor appears. 

The audit trail can be downloaded to a comma-separated (.csv) file by clicking the 
Download Audit Trail link. The file is downloaded to the default download location 
on the local machine. 

 



Release Notes 

SAP Concur Release Notes Page 8 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

Configuration / Feature Activation 

This feature is automatically available; there are no additional configuration or 
activation steps. 

 For more information about the Create and Approve Vendors feature, refer to 
the Invoice: Vendor Manager User Guide. 

Create and Approve Vendors Feature Available in Test 
Environments (Released February 22) 

Overview 

The Create and Approve Vendors feature is now available in test environments.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change enables developers and implementation teams to work with the Create 
and Approve Vendors feature prior to moving to a production environment. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

Support for Multi-Level Connected Lists With Create and Approve 
Vendors Feature (Released January 29) 

Overview 

On entities with the Create and Approve Vendors feature enabled, the vendor 
information form now supports the use of multi-level, connected lists. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature enables the Invoice Configuration Administrator to customize the vendor 
information form with multi-level list fields.  

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

 For more information, refer to the Invoice: Vendor Manager User Guide, the 
Invoice: Forms and Fields Setup Guide, and the Shared: List Management 
Setup Guide. 
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Invoice E-Bunsho Timestamp 

Updated Invoice E-Bunsho Timestamp Icon 

Overview 

The icon for the Invoice e-Bunsho Timestamp feature has been updated from an 
analog clock symbol ( ) to a check mark symbol ( ). 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change improves the usability of the feature. 

What the User Sees 

When the user views a list of their invoices on the Invoice > Manage Requests > 
My Requests > Payment Request List page, if an invoice in the list includes a 
successfully timestamped invoice image, the e-Bunsho timestamp icon ( ) appears 
below the date in the Invoice Date column for that invoice. 

 

Configuration / Feature Activation 

The update is automatically available; there are no additional configuration or 
activation steps. 

Company Administration 

New SSL Certificate for concursolutions.com 

Overview 

In an effort to ensure the ongoing security of our products and services, SAP Concur 
has issued a new concursolutions.com SSL certificate. The current certificate will 
expire on March 16, 2019. 
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Any client who has pinned this expiring certificate will need to update to the new 
certificate prior to March 16, 2019. If the pinned certificate is not updated prior to 
March 16, 2019, the client's organization and users will experience disruption to SAP 
Concur products and services. 

Clients who have not pinned the certificate do not need to take any action as the 
new certificate is updated automatically. Most clients do not pin the certificate. 

Please be aware: As an enhancement to our Security and Compliance program, 
this certificate will be updated on an annual basis. 

BUSINESS PURPOSE / CLIENT BENEFIT  

This update provides ongoing security for our products and services.  

Configuration / Feature Activation 

The new SSL certificate can be downloaded here:  
http://assets.concur.com/concurtraining/cte/en-us/concursolutions.cert.pem 

SAP Concur Email 

**Ongoing** Email Infrastructure Change - Add IP Addresses to 
Safe Senders List 

Overview 

SAP Concur is transitioning to a new email infrastructure for outbound email from 
our services to SAP Concur users. Because of this, companies that filter inbound 
email based on the sending IP address must add new IP addresses to their Safe 
Senders list to ensure that their users receive email from SAP Concur. 

IMPORTANT: All Services Will Soon Be Affected 

Initially, the issue described here affected only companies that use Concur Expense. 
Starting in January, email from other SAP Concur services (such as Concur Travel 
and Concur Pay) will move to the new email infrastructure.  

We will continue to add other services throughout the first quarter of 2019. Please 
monitor the release notes for more information about the timing of the additional 
changes. 

NOTE: This change only affects companies that filter incoming email based on IP 
addresses. 

http://assets.concur.com/concurtraining/cte/en-us/concursolutions.cert.pem
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Configuration / Feature Activation 

The new IP addresses are not published publicly but they are available by contacting 
SAP Concur support. If your company uses Concur Expense and if your company 
filters incoming email based on IP address, please work with your email server 
management team to ensure that all required IP address Safe Senders lists are 
updated so that your users continue to receive SAP Concur email without 
interruption. 

**Ongoing** Updated Email Format 

Overview 

SAP Concur has provided a release note about the updated email notifications for 
several months. Be aware that we will discontinue this release note in two 
months. 

IMPORTANT 

Note the following: 

• The email content has not changed – just the look and feel has been updated. 

• The changes will appear over time. Each product team (Expense, Invoice, 
Travel, etc.) decides when to use the new format. Timing will be based on 
resource availability and the priority of other scheduled enhancements.  

NOTE: One sample from Expense is shown below. No other samples from 
other products will be shown in these release notes. 

• Do not expect that all product emails will change at the same time. For 
example, the Expense approval email might be first, and then other Expense 
notifications might follow.  

• There is no assigned end date for the project. The changes might take longer 
than a year. 

IMPORTANT for SSO Clients 

For clients who use SSO, a lengthy URL might be replaced with 
www.concursolutions.com. For example, the URL in the expense report status 
change email might be replaced. Because some URLs can reach 200 characters in 
length, the decision was made to provide the www.concursolutions.com link instead, 
providing a better experience for users. 

NOTE: Even though clients can define URLs that are an acceptable length, the SAP 
Concur system appends additional characters – primarily to satisfy mobile 
requirements – and those extra characters can extend the URL up to 200 
characters.  
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The link in the email still works as it always has – redirecting the user for proper SSO 
authentication. The user can see the underlying URL at any time by hovering the 
mouse pointer over the www.concursolutions.com link.  

This change does not affect those emails where the user clicks a button – instead of 
a link – to access Concur Expense.  

What the User Sees 

New email look-and-feel: 

 

Configuration / Feature Activation 

This change will occur, over time, automatically; there are no additional 
configuration or activation steps. 
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SAP Concur Support Portal 

Security Questions Available When Using the SAP Concur Support 
Portal 

Overview 

Prior to 2017, Authorized Support Contacts (ASCs) using the SAP Concur support 
portal were required to answer security questions prior to interacting with support. 
This feature was retired while it was being redesigned. 

As of January 3, the feature is again available.  

BUSINESS PURPOSE / CLIENT BENEFIT 

Clients appreciate this feature because it provides another layer of security. It 
prevents someone from impersonating: 

• An ASC and then requesting an improper or unexpected configuration change 

– or – 

• An end user and then accessing their confidential data  

What the ASC Sees 

ASCs can turn on the Security Questions feature, as described below. The Security 
Questions feature: 

• Is optional and OFF by default 

• Can be enable by any ASC for the following users: 

♦ ASCs within the company 

♦ End users within the company (if they use the User Support Desk service) 

♦ ASCs and end users within the company (if they use the User Support 
Desk service) 

Be aware that:  

• If an ASC enables the feature, then it is enabled for all the company's 
ASCs/end users (depending on the option selected when enabled).  

• Using security questions applies to everyone, but each ASC/end user defines 
which security questions they answer. 

• Any other ASC can disable the feature or change which audience has to 
answer the questions. 

• All ASCs within a company should discuss and agree on their plan for this 
feature. The actions of the ASC enabling/disabling the feature or changing the 
audience is not logged. It is very important that all ASCs in a company agree 
on how this feature will work for their company and who can make changes. 
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SAP Concur cannot enable this feature on behalf of a company or an ASC. 

ENABLE OR DISABLE THE FEATURE 

The ASC can enable/disable the feature in My Profile in the SAP Concur support 
portal. 

 

On the User Information Confirmation page, the new Additional Call Center 
Security Questions section is used to enable the feature. The ASC can also define 
the security questions they want to answer. 
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When the ASC selects an option other than None, the section expands so the ASC 
can choose their desired questions.  

 

NOTE: Regarding the questions and answers provided by the ASC, they apply only to 
that ASC. They will be available only in that ASC's profile; they will not be 
seen by other ASCs or end users. 

How it Works 

Once the feature is enabled, when ASCs/end users (depending on the option selected 
when enabled) sign in to the SAP Concur support portal, they are presented with 
their User Information Confirmation page. They must answer their security 
questions and save. 

NOTE: Once they have entered their answers, those answers are visible only to them 
and to SAP Concur employees. 

Then, when the ASC and/or end user calls SAP Concur (or asks SAP Concur to call 
them back), the SAP Concur support employee will access the caller's record and ask 
the security questions. 
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Then:  

• If the caller answers the questions correctly, the support employee clicks I 
Acknowledge and the call continues. 

• If the caller cannot answer the questions correctly, the support employee 
clicks Go Back. The caller is instructed to sign in to the SAP Concur support 
portal and review the questions/answers and make any necessary changes. 
The changes will be immediate, and the questions can be asked again of the 
caller or the caller can call back once they update their questions. 

Chat is not affected by the security questions. Since the user has already signed in 
with the proper credentials, the SAP Concur support employee will simply click I 
Acknowledge. 

Configuration / Feature Activation 

The feature is currently available. 

Miscellaneous 

Reminder: No Personal or Sensitive Data in Custom Fields 

Overview 

All companies must take all reasonable steps to protect the personal and sensitive 
information of their employees. Per recommended security-related best practices, 
custom fields should not contain personal or sensitive data. 

! IMPORTANT: Data in custom fields is not encrypted. The client is solely 
responsible for any liability resulting or arising from improper use. 

Next Steps 

If your company is currently using custom fields to store personal or sensitive data 
(for example, Social Security numbers, family member names, or any other 
personally identifying information), you should plan to remove this information from 
your existing fields within the service and modify your current configuration. 

 For additional information, refer to the FAQ. 

http://www.concurtraining.com/customers/tech_pubs/Security/FAQ_Sensitive_Data_Jan312019.pdf


Planned Changes 

SAP Concur Release Notes Page 17 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

Planned Changes 
The items in this section are targeted for future releases. SAP Concur reserves the 
right to postpone implementation of – or completely remove – any 
enhancement/change mentioned here. 

Concur Invoice 

**Planned Changes** New User Interface for Concur Invoice 
Targeted for April Release 

Overview 

SAP Concur will soon offer a new user experience that is particularly targeted at the 
Accounts Payable (AP) user who is constantly monitoring the health of the Invoice 
lifecycle within the system. With a new AP landing page, concepts of "call to action" 
and "work to zero" are being brought to the forefront to better inform AP users to 
ensure they are working on the highest priority task. 

The new user interface in Concur Invoice that clients can now review and familiarize 
themselves with is targeted for general availability the second quarter in 2019.  

NOTE: Contact your SAP Concur representative for more information about the Early 
Access program. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 
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What the Invoice AP User and Invoice Processor See 

The Invoice AP User and the Invoice Processor will now land on a new Invoice 
Manager page that provides key information about all active invoices. 

 

On the Invoice Manager tab, the Invoice AP User and Invoice Processor see new 
tiles and new sections including visibility into Active Invoices and My Tasks 
sections. 

The Invoice Processor also sees a newly designed Unassigned Invoices page that 
is more modern and aligns with Next Gen UI initiatives across the SAP Concur Spend 
platform. 
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What the Invoice User Sees 

Invoice users who have access to My Requests, will see a newly designed My 
Invoices page that is more modern and aligns with Next Gen UI initiatives across 
the SAP Concur Spend platform. 

 

Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 

 

NOTE: More information about the new Concur Invoice user interface will be made 
available in future release notes. 
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**Planned Changes** Payment Request(s) Renamed to Invoice(s) 

Overview 

In a future release, SAP Concur will replace instances of the term "payment request" 
and its iterations with the term "invoice" and its iterations. These changes will be 
made in the user interface, the Concur Invoice documentation, and in all other SAP 
Concur product documentation where it appears. 

NOTE: The term change is targeted for the April release. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change helps to ensure that the terminology used in SAP Concur is consistent 
with industry standard terminology. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

Purchase Order 

**Planned Changes** Import Now for PO and PO Receipt Imports 

Overview 

The Import Now feature enables clients to import PO and PO receipt files into Concur 
Invoice immediately without having to wait for an overnight scheduled import. This is 
beneficial for clients who need to import POs and PO receipts and work with them in 
the Concur Invoice product the same day they are created externally. This also 
allows clients to do multiple PO and PO receipt imports a day for more synchronized 
and up-to-date data. 

NOTE: The Import Now feature is currently in an Early Adopter program. For more 
information, contact your SAP Concur representative. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature gives clients control over when and how frequently to import POs and 
PO receipts into Concur Invoice. 
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Configuration / Feature Activation 

This enhancement is automatically available. To start using this feature, clients need 
to add the suffix "importnow" on their PO and PO receipt files that are transferred to 
their FTP site. 

Current Import Naming Convention 

The current naming conventions are as follows:  

• PO import: poinvoice_EntityID_Date 

• PO Receipt Import: purch_receipt_EntityID_Date 

These naming conventions will remain as is today and the files will continue to be 
picked up and run on the existing schedule. Clients who wish to always import these 
records using the import now option should adjust their schedules accordingly and 
remove any scheduled jobs from the purchase order and purchase order receipt 
import job definitions. 

Import Now Naming Convention 

The Import Now naming conventions are as follows:  

• PO Import: poinvoiceimportnow_EntityID_Date 

• PO Receipt Import: purch_receiptimportnow_EntityID_Date 

For the Import Now option, the PO receipt file is usually dependent on the PO file, so 
clients must coordinate their file transfer to the FTP site so that the PO file is always 
transferred first before the PO receipt file to ensure the PO’s are imported before the 
receipts. The PO receipt Import Now function will not start until any active PO import 
running is completed. However, once the PO files are sent with the "importnow" 
suffix, they will be imported immediately when they are transferred to the FTP site. 

NOTE: Clients must have an FTP site to use this feature. 

Budget 

**Planned Changes** Workflows for Budget 

Overview 

In a future release, workflows will be available for Budget. Workflows define how the 
system routes invoices, expense reports, and requests through approval and 
processing steps. The flexible workflow feature for Budget that SAP Concur offers 
allows companies to design workflows specifically tailored to their unique needs.    
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Without budget review, budgets may become fully consumed well before the end of a 
period or year leaving an organization with limited options and budget owners with, 
for example, exceeded budgets. In addition, early spending means spending that is 
more important to the organization will be declined because less important spending 
consumed the budget early on.  

Combining budget review in the workflow adds value. Audit rules and workflow step 
rules can help organizations to add in controls when it makes sense to fine tune to 
an organization's specific needs.  

Equally important is the determination when a spending item is regarded as 
committed toward a budget. In most organizations, the commit is when a spending 
item is paid; it went through most if not all approval steps. In other organizations, 
the commit occurs much earlier. As soon as a purchase request or an authorization 
request is approved it is regarded as "promised".    

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature will provide clients with control over the budget spend to, for example, 
avoid exceeded budgets too early in a budget period or budget year.   

Configuration / Feature Activation 

The administrator must configure this feature on the Approval Routing page. 

 To access the Approval Routing page: 

1. Click Administration > Invoice Settings or Expense Settings or Expense 
& Invoice Settings. 

2. In the Product list, click Invoice or Expense depending on the product you 
are working with. 

3. In the Policy section, click Show Advanced Settings. 

4. Click Invoice Approvals, Expense Approvals, or Purchase Request 
Approvals. 

Company Administration 

**Planned Changes** Single Sign-On (SSO) Self-Service Option 
Coming to SAP Concur 

Overview 

Single Sign-On allows users to access multiple applications using one set of login 
credentials. Currently, SAP Concur has two methods for signing in: with a user name 
and password or using SSO with identity provider (IdP) credentials, such as a user's 
login credentials for their organization. 
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SAP Concur is planning to add a Manage Single Sign-On (SSO) feature to SAP Concur 
which provides SAP Concur clients with a self-service option for setting up SSO for 
their organization. SSO is currently supported for Concur Expense, Concur Invoice, 
Concur Request, and Concur Travel. 

Other SAP Concur products and services are outside the scope of this initial release. 

The new Manage Single Sign-On (SSO) feature will be accessible from the 
Administration > Company > Company Admin page. 

NOTE: This new feature does not affect Concur Travel clients who are already using 
the Security Keys feature. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides SAP Concur clients with a self-service option for setting up 
SSO. 

Configuration / Feature Activation 

Configuration information will be coming in a future release note. 

**Planned Changes** New SAP Concur Sign In Page 

Overview 

SAP Concur is planning to add a new Sign In page, providing an updated login 
experience for users who log in with user name and password credentials. Current 
Single Sign-On (SSO) users will log in without having to enter additional credentials. 
This feature is planned for 2019. 

The new Sign In page feature includes the following: 

• Two-step login: provides enhanced security, meets current industry 
standards, and provides a better log in success rate 

• Multi-account login: allows administrators to log in with multiple accounts 

• Password hint removal: provides better security for users and SAP Concur 

• User avatar: enhances the user experience (planned for a future release) 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides better security and a faster, more convenient experience for 
users logging in to SAP Concur products and services. 



Planned Changes 

SAP Concur Release Notes Page 24 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

What the User Sees – Current Sign In Page 

The SAP Concur Sign In page currently appears with User Name and Password 
fields, and a Sign In button. Once a user is authenticated, the SAP Concur Home 
page appears. 
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What the User Sees – New Sign In Page 

The new SAP Concur Sign In page will have an Email or Username field and a 
Continue button. The user will type in their email or username. The user can select 
the Remember me on this computer check box, so their email or username is 
stored and will not have to be reentered the next time they log in to SAP Concur.  

After entering their email or username, the user will then click Continue. 

 

Depending on the client’s implementation of SAP Concur, users will then be directed 
to the designated Identity Provider (IdP) Single Sign-On portal or an additional Sign 
In page. 



Planned Changes 

SAP Concur Release Notes Page 26 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

SSO USERS 

When the designated Identity Provider (IdP) Single Sign-On portal appears (similar 
to the one shown below), the user will enter their email or username, and their 
password, and then click Sign In. After being authenticated, the user will be 
directed to the SAP Concur Home page. 

 

After being authenticated, the user will be directed to the SAP Concur Home page. 
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USERS WITH USERNAMES AND PASSWORDS 

The user will be directed to an additional Sign In page. The user will enter a 
password and click Sign In. The system will then authenticate the user's credentials. 

 

Once the user’s password is verified, the SAP Concur Home page appears. 

RETURN USERS 

If a returning user selected the Remember me on this computer check box during 
their initial login session, they will see their email or user name displayed on the 
Sign In page. Users who did not select the Remember me on this computer 
check box will log in as they did initially. 
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The user will click on their username, and then and then one of the following occurs: 

• SSO Users: The user will be directed to the SAP Concur Home page. 

• Users with Usernames and Passwords: On the Sign In page, the user 
will enter a password and then click Sign In. The user will then be directed to 
the SAP Concur Home page. 

USERS WITH MULTIPLE ACCOUNTS 

SAP Concur users with multiple login accounts have more than one login option 
depending on the user role or account they want to use. The user will first log in to 
SAP Concur using one of their accounts. Once successfully logged in, the user logs 
out of the system. 

To add another account, on the Sign In page, the user clicks the Use Another 
Account link. 

 

The next login step depends on the account type the user wishes to use: 

• SSO Account: If the user selects an account with SSO credentials, the user 
will enter an email, then the user will be directed to the IdP Single Sign-On 
portal. Once the user is authenticated, the SAP Concur Home page appears. 

• Username and Password: The user is directed to an additional Sign In 
page to enter a password. The user then clicks Sign In. Once the user is 
authenticated, the SAP Concur Home page appears. 
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When all of the accounts have been added, a return user will select the account they 
want to use to log in to SAP Concur. 

 

FORGOT USER NAME 

If a user forgets their user name, the user will click the Forgot username? link on 
the Sign In page.  
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Next, the Forgot User Name page appears. On the Forgot User Name page, the 
user will enter their email and click Send to have an email sent to a verified email 
account. The email will contain their user name. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 
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INVALID PASSWORD 

If a user forgets their password, an on-screen message will appear alerting the user. 
The user will then click Send to have a password reset email sent to their verified 
email account. 

SAP Concur compares the email address entered by the user to the email address in 
the user's SAP Concur profile. If the email addresses match, then SAP Concur 
generates a one-time sign-in token (link) that can be used for one hour. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 

 

Configuration / Feature Activation 

Configuration information will be provided in a future release note. 

Training Administration  

**Planned Changes** Optimizing and Relocating the Page 

Overview 

To simplify the Training Administration page, the functionality and content will be 
changing. 

In addition to content changes, access to the Training Administration page will 
move from Company Admin to Tools. 
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BUSINESS PURPOSE / CLIENT BENEFIT 

These changes will make the Training Administration feature easier to find and use. 

Configuration / Feature Activation 

The changes will be automatically available; additional information about potential 
configuration or activation steps will be provided in a later version of these release 
notes. 

 For general information about the Training Administration feature, refer to 
the Shared: Training Administration Setup Guide. 

Test User Admin 

**Planned Changes** Retiring the Purge Test User Transactions 
Functionality 

Overview 

SAP Concur is retiring the functionality in the Test User Admin feature that removes 
the transactions of test users from Concur Expense, Concur Invoice, Concur Travel, 
and Concur Request.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will allow SAP Concur to devote more resources to development and 
maintenance of features that are used by many or most of our clients. 

What the Admin Sees  

The Test User Admin page will no longer display the Purge Test User 
Transactions button. 
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Before 

 

NOTE: To access the page, click Administration > Expense (or Invoice or 
Requests) > Test User Admin. 

After 

  

Configuration / Feature Activation 

The functionality will automatically be removed. 

 For general information about the Test User Admin feature, refer to 
the Shared: Test User Setup Guide. 

Miscellaneous 

**Planned Changes** Archive Deactivated User Data 

This information will no longer appear in the release notes. 

 For more information about deactivated users, refer to the General 
Information: Archiving Deactivated User Data Fact Sheet. 
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Client Notifications 

Subprocessors 

SAP Concur Non-Affiliated Subprocessors 

The list of non-affiliated subprocessors is available here: SAP Concur list of 
Subprocessors 

If you have questions or comments, please reach out to: Privacy-
Request@Concur.com  

Browser Certifications 

Monthly Browser Certifications and Supported Configurations 

The SAP Concur Release Notes – Monthly Browser Certifications document lists 
current and planned browser certifications. The document is available with the other 
SAP Concur monthly release notes. 

 For information about accessing all release notes, browser certifications, 
setup guides, user guides, other technical documentation, and supported 
configurations, refer to the Additional Release Notes and Other Technical 
Documentation section in this document. 

https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
mailto:Privacy-Request@Concur.com
mailto:Privacy-Request@Concur.com
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SAP Concur Support Case Status 
This release might resolve previously submitted support cases. You can check the 
status of a support case to confirm whether the case issue has been resolved. 

Check Support Case Status 

The steps in this procedure provide instructions for checking whether a case is 
resolved. 

 To check the status of a submitted case: 

1. Log on to https://concursolutions.com/portal.asp. 

2. Click Help > Contact Support.  

  

The SAP Concur support page displays. 

 

https://concursolutions.com/portal.asp
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If the Contact Support option is not available in the Help menu, then your 
company has chosen to support the SAP Concur system internally. Please 
contact your internal support desk for assistance. 

3. In the Quick Search field, enter your Case ID. 

4. Click Search. Search results are limited to each company's own cases. 

February Example 

The table below contains some example cases that are resolved in this release. It is 
not a comprehensive list of the resolved cases. 

 
Case ID Description 

12371248 
Audit Rules 

Audit rule did not run as expected. 

13148588 

Payment Manager 
The Invoice > Payment Manager > Extract Reconciliation page did not 
load correctly. 

13087480 

Approval Routing 
Invoice Approval moved two steps forward in workflow when inadvertently 
clicked twice in succession. 

12707361 
Create and Approve Vendors 
Unable to edit vendors in Create and Approve Vendors user interface. 
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Additional Release Notes and Other Technical 
Documentation 

Online Help – Admins 

A user who is assigned an admin role can access release notes, setup guides, user 
guides, admin summaries, monthly browser certifications, supported configurations, 
and other resources through Invoice Administration Help. 

 



Additional Release Notes and Other Technical Documentation 

SAP Concur Release Notes Page 40 Invoice Professional/Premium 
Release Date: February 9, 2019  SAP Concur Client FINAL 
Update #3: Friday, February 22, 2:30 PM PST 
 

SAP Concur Support Portal – Selected Users 

Users who are assigned the correct SAP Concur support portal permissions can 
access release notes, setup guides, user guides, admin summaries, monthly browser 
certifications, supported configurations, and other resources through the SAP Concur 
support portal. 

 To access the SAP Concur support portal (for users with the correct 
permissions): 

1. Click Help > Contact Support.  

2. On the support page, click Resources > Release/Tech Info. 
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statements, which speak only as of their dates, and they should not be relied upon in 
making purchasing decisions. 



SAP Concur Release Notes Page i Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

SAP Concur Release Notes 

Invoice Professional/Premium 
Includes: Concur Invoice, Capture Processing, Invoice Pay, Purchase Requests and Purchase Orders 

 

Month Audience 

Release Date: March 16, 2019 
Update 1: Wednesday, April 3, 12:00 PM PST SAP Concur Client FINAL 

 

Contents 

Release Notes ....................................................................................................... 2 
Concur Invoice ....................................................................................................2 

**Reminder** New User Interface for Concur Invoice Accounts Payable Available for 
Client Review and Opt-In .................................................................................... 2 

E-Bunsho Timestamp Feature for Invoice Generally Available (Japan) ......................... 3 
Purchase Request ................................................................................................4 

Set Default Value of Receipt Type Field on the Purchase Request Item Form ................ 4 
Purchase Order ...................................................................................................5 

Purchase Order List Available for Clients Who Import Purchase Orders for Matching ...... 5 

Shipping Configuration Page Available to Purchase Order Clients................................ 6 
Vendor Management............................................................................................7 

Audit Trail for Vendor Changes (Released February 22) ............................................ 7 

Create and Approve Vendors Feature Available in Test Environments (Released February 
22) ................................................................................................................. 9 

Company Administration.................................................................................... 10 

New SSL Certificate for concursolutions.com – Updated Date .................................. 10 
Concur Open ..................................................................................................... 11 

Messaging for Concur Open and Personalized Concur Open ..................................... 11 
SAP Concur Email .............................................................................................. 12 

**Ongoing** Email Infrastructure Change - Add IP Addresses to Safe Senders List..... 12 

**Ongoing** Updated Email Format ................................................................... 12 
Miscellaneous.................................................................................................... 14 

Reminder: No Personal or Sensitive Data in Custom Fields ...................................... 14 

Planned Changes ................................................................................................ 16 



SAP Concur Release Notes Page ii Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

Concur Invoice .................................................................................................. 16 

**Planned Changes** New User Interface for Concur Invoice Targeted for April Release16 

**Planned Changes** Payment Request(s) Renamed to Invoice(s) .......................... 19 
Purchase Order ................................................................................................. 19 

**Planned Changes** Import Now for PO and PO Receipt Imports ........................... 19 
Budget .............................................................................................................. 20 

**Planned Changes** Workflows for Budget ........................................................ 20 
Security ............................................................................................................ 21 

**Planned Changes** No Future Bulk Password Resets or Updates via Import File...... 21 
Company Administration.................................................................................... 22 

**Planned Changes** Composite Logins to be Deprecated ..................................... 22 

**Planned Changes** Single Sign-On (SSO) Self-Service Option Coming to SAP Concur25 

**Planned Changes** New SAP Concur Sign In Page ............................................. 26 

**Planned Changes** New Forgot Password Page and Related Feature Deprecation .... 36 
Training Administration ..................................................................................... 42 

**Planned Changes** Optimizing and Relocating the Page ..................................... 42 
Test User Admin ................................................................................................ 43 

**Planned Changes** Retiring the Purge Test User Transactions Functionality ........... 43 

Client Notifications ............................................................................................. 45 
Subprocessors................................................................................................... 45 

SAP Concur Non-Affiliated Subprocessors............................................................. 45 
Browser Certifications ....................................................................................... 45 

Monthly Browser Certifications and Supported Configurations .................................. 45 

SAP Concur Support Case Status ....................................................................... 46 
Check Support Case Status ................................................................................ 46 

March Example ............................................................................................... 47 

Additional Release Notes and Other Technical Documentation ....................... 49 
Online Help – Admins ........................................................................................ 49 
SAP Concur Support Portal – Selected Users ....................................................... 50 



Release Notes 

SAP Concur Release Notes Page 1 Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

Legal Disclaimer 
The information in this presentation is confidential and proprietary to SAP SE or an 
SAP affiliate company and may not be disclosed without the permission of SAP SE or 
the respective SAP affiliate company. This presentation is not subject to your license 
agreement or any other service or subscription agreement with SAP SE or its 
affiliated companies. SAP SE and its affiliated companies have no obligation to 
pursue any course of business outlined in this document or any related presentation, 
or to develop or release any functionality mentioned therein. This document, or any 
related presentation and SAP SE or an SAP affiliate company’s strategy and possible 
future developments, products and or platforms directions and functionality are all 
subject to change and may be changed by SAP SE and its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise or legal obligation to deliver any material, code or 
functionality. This document is provided without a warranty of any kind, either 
express or implied, including but not limited to, the implied warranties of 
merchantability, fitness for a particular purpose, or non-infringement. This document 
is for informational purposes and may not be incorporated into a contract. SAP SE 
and its affiliated companies assume no responsibility for errors or omissions in this 
document, except if such damages were caused by SAP SE or an SAP affiliate 
company’s willful misconduct or gross negligence.  

All forward-looking statements are subject to various risks and uncertainties that 
could cause actual results to differ materially from expectations. Readers are 
cautioned not to place undue reliance on these forward-looking statements, which 
speak only as of their dates, and they should not be relied upon in making 
purchasing decisions. 



Release Notes 

SAP Concur Release Notes Page 2 Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

Release Notes 
This document contains the release notes for Concur Invoice functionality for 
professional edition. 

Concur Invoice 

**Reminder** New User Interface for Concur Invoice Accounts 
Payable Available for Client Review and Opt-In  

Overview 

Clients still have the opportunity to familiarize themselves with the new user 
interface as SAP Concur prepares for general availability targeting the second quarter 
in 2019.  

Updates for March 

For clients reviewing this feature, SAP Concur has now added the following features: 
 

• Title has been renamed to Invoice Name in the Search list on the My 
Invoices page 

• Window appears on submit or assign asking users if they want to go to the 
next invoice or return to the list of invoices 

• In the View menu, on the My Invoices page, the Purchase Order Invoices 
option has been renamed to All Sent to Purchasing and a new Sent to 
Purchasing option has been added 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 

Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 
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 For more information, refer to the Concur Invoice Accounts Payable User 
Experience Enhancement Client Fact Sheet and the **Planned Changes** 
New User Interface for Concur Invoice Soon Available release note in this 
document. 

E-Bunsho Timestamp Feature for Invoice Generally Available 
(Japan) 

Overview 

With the e-Bunsho Timestamp feature for Japan, Invoice now supports digital 
timestamps of invoice images from companies and invoice service suppliers. 

When this feature is enabled, rules are put in place to ensure that users provide the 
necessary invoice information to maintain legal compliance with Japan’s e-Bunsho 
regulation. A user must first confirm the invoice image is the valid image for the 
invoice being entered before they can timestamp the image and the invoice cannot 
be submitted for approval until the Invoice image has been successfully 
timestamped. 

There is a validation process for monitoring received, pending, requested, and 
ineligible timestamps. The validation process revalidates the successfully 
timestamped invoice images and displays counts and totals by date range for valid 
and invalid timestamped images. 
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BUSINESS PURPOSE / CLIENT BENEFIT 

This feature enables clients in Japan to maintain legal compliance with e-Bunsho 
regulations if they use digital invoices in lieu of paper invoices. 

What the Admin Sees 

The admin sees a new list in the Policies tool. 

Configuration / Feature Activation  

If you are interested in enabling this feature, contact your Account Manager or 
Project Manager. 

 For more information about this feature, refer to the Japan e-Bunsho 
Timestamp Feature fact sheet for Invoice Professional. 

Purchase Request 

Set Default Value of Receipt Type Field on the Purchase Request 
Item Form 

Overview 

A Concur Invoice administrator with the appropriate permissions can now configure 
the default value for the Receipt Type field that appears on the Purchase Request 
Item form. Prior to this change, the Receipt Type field defaulted to Quantity 
Receipt for goods items and None for service items. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature enables an administrator to set the default value for the Receipt Type 
for goods items and service items to either Quantity Receipts or None to ensure 
that the receipt type defaults to the desired value. 

What the Invoice Admin Sees 

On the Concur Invoice Forms and Fields page, when the admin configures the 
Receipt Type field for a Purchase Request Item form, the admin can set the 
Default Value Type to Constant and can select the desired default value from the 
drop-down menu in the Default Value field. 
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Configuration / Feature Activation 

This feature is automatically available; there are no additional configuration or 
activation steps. 

Purchase Order 

Purchase Order List Available for Clients Who Import Purchase 
Orders for Matching 

Overview 

For clients who import purchase orders on entities that do not have the Purchase 
Request feature enabled, a user who is assigned the Purchasr Order Processor or 
Purchase Order Processor (Audit) role can now see a list of imported purchase 
orders. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature enables clients that handle purchase order invoices to more easily 
manage and view imported purchase orders. 

What the Purchasing Admin Sees 

Users with the Purchasing Order Processor or Purchase Order Processor (Audit) role 
see a list of imported purchase orders on the Requests > All Purchase Orders 
page. 
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Configuration / Feature Activation 

This feature is automatically available; there are no additional configuration or 
activation steps. 

Shipping Configuration Page Available to Purchase Order Clients 

Overview 

For clients who import purchase orders on entities that do not have the Purchase 
Request feature enabled, a user who is assigned the Invoice Configuration 
Administrator or Invoice Configuration Administrator (Restricted) role now has 
access to the Administration > Invoice > Shipping Configuration page. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The Shipping Configuration page enables clients to create shipping methods (for 
example, FedEx 2Day and UPS Ground) and shipping terms (for example, FOB) 
which can be included on purchase orders imported from an external system. 

What the Purchasing Admin Sees 

Users with the Invoice Configuration Administrator or Invoice Configuration 
Administrator (Restricted) role see Shipping Configuration on the Invoice 
Processing Admin menu on the Administration > Invoice page.  
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After clicking Shipping Configuration, the Shipping Configuration page appears. 
On the Shipping Configuration page, the admin can create, edit, and delete 
shipping methods and shipping terms. 

 

Configuration / Feature Activation 

This feature is automatically available to users with the Invoice Configuration 
Administrator or Invoice Configuration Administrator (Restricted); there are no 
additional configuration or activation steps. 

Vendor Management 

Audit Trail for Vendor Changes (Released February 22) 

Overview 

Clients with the Create and Approve Vendors feature enabled can now track changes 
to a vendor through the Audit Trail page within the vendor record in Vendor 
Manager. For example, when a vendor is approved or updated by the Vendor 
Manager, those actions appear on the Audit Trail page.  
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NOTE: The Create and Approve Vendors feature is disabled by default on Professional 
entities. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change enables users with the Invoice Vendor Manager role to track changes 
made to vendor information in Vendor Manager. 

What the Vendor Manager Sees 

Within an open vendor record, in the Actions menu, the Vendor Manager will see a 
new option, View Audit Trail. 
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After clicking View Audit Trail, the audit trail page for the selected vendor appears. 

The audit trail can be downloaded to a comma-separated (.csv) file by clicking the 
Download Audit Trail link. The file is downloaded to the default download location 
on the local machine. 

 

Configuration / Feature Activation 

This feature is automatically available; there are no additional configuration or 
activation steps. 

 For more information about the Create and Approve Vendors feature, refer to 
the Invoice: Vendor Manager User Guide. 

Create and Approve Vendors Feature Available in Test 
Environments (Released February 22) 

Overview 

The Create and Approve Vendors feature is now available in test environments.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change enables developers and implementation teams to work with the Create 
and Approve Vendors feature prior to moving to a production environment. 
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Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

Company Administration 

New SSL Certificate for concursolutions.com – Updated Date 

Overview 

In an effort to ensure the ongoing security of our products and services, SAP Concur 
has issued a new concursolutions.com SSL certificate. The current certificate will 
expire on March 16, 2019. 

Any client who has pinned this expiring certificate will need to update to the new 
certificate prior to March 16, 2019. If the pinned certificate is not updated prior to 
March 16, 2019, your organization and users will experience disruption to SAP 
Concur products and services. 

Clients who have not pinned the certificate do not need to take any action as the 
new certificate is updated automatically. Most clients do not pin the certificate. 

Please be aware: As an enhancement to our Security and Compliance program, 
this certificate will be updated on an annual basis. 

BUSINESS PURPOSE / CLIENT BENEFIT  

This update provides ongoing security for our products and services. 

Configuration / Feature Activation 

Please consult with your IT department to check if this applies to you.  

The new SSL certificate can be accessed here:  
http://assets.concur.com/concurtraining/cte/en-us/concursolutions.cert.pem 

Supply this URL to your IT department.  

To save the certificate, click the link above, select all the text in the browser, copy it 
to a file, then name the file concursolutions.cert.pem. 

http://assets.concur.com/concurtraining/cte/en-us/concursolutions.cert.pem
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Concur Open 

Messaging for Concur Open and Personalized Concur Open 

Overview 

Concur Open and Personalized Concur Open users can subscribe to email 
notifications about the SAP Concur products they use. As part of the subscription 
process, SAP Concur sends a verification email to the user. The user must click 
Verify in the email in order to receive the notifications. 

Because some users are not completing the verification step, SAP Concur has added 
a reminder to the subscription page. 

NOTE: This message appears only if the subscriber has not responded to the 
verification email. 

 For more information about Personalized Concur Open, refer to the 
Personalized Concur Open fact sheet. 

What the User Sees 

The following highlighted message appears on the Personalized Concur Open 
subscription page. 

 

A similar message appears for Concur Open users. 

Configuration / Feature Activation 

The feature is automatically on; there are no additional configuration or activation 
steps. 
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SAP Concur Email 

**Ongoing** Email Infrastructure Change - Add IP Addresses to 
Safe Senders List 

Overview 

SAP Concur is transitioning to a new email infrastructure for outbound email from 
our services to SAP Concur users. Because of this, companies that filter inbound 
email based on the sending IP address must add new IP addresses to their Safe 
Senders list to ensure that their users receive email from SAP Concur. 

IMPORTANT: All Services Will Soon Be Affected 

Initially, the issue described here affected only companies that use Concur Expense. 
Starting in January, email from other SAP Concur services (such as Concur Travel 
and Concur Pay) will move to the new email infrastructure.  

We will continue to add other services throughout the first quarter of 2019. Please 
monitor the release notes for more information about the timing of the additional 
changes. 

NOTE: This change only affects companies that filter incoming email based on IP 
addresses. 

Configuration / Feature Activation 

The new IP addresses are not published publicly but they are available by contacting 
SAP Concur support. If your company uses Concur Expense and if your company 
filters incoming email based on IP address, please work with your email server 
management team to ensure that all required IP address Safe Senders lists are 
updated so that your users continue to receive SAP Concur email without 
interruption. 

**Ongoing** Updated Email Format 

Overview 

SAP Concur has provided a release note about the updated email notifications for 
several months. Be aware that we will discontinue this release note after this 
month. 

IMPORTANT 

Note the following: 

• The email content has not changed – just the look and feel has been updated. 
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• The changes will appear over time. Each product team (Expense, Invoice, 
Travel, etc.) decides when to use the new format. Timing will be based on 
resource availability and the priority of other scheduled enhancements.  

NOTE: One sample from Expense is shown below. No other samples from 
other products will be shown in these release notes. 

• Do not expect that all product emails will change at the same time. For 
example, the Expense approval email might be first, and then other Expense 
notifications might follow.  

• There is no assigned end date for the project. The changes might take longer 
than a year. 

IMPORTANT for SSO Clients 

For clients who use SSO, a lengthy URL might be replaced with 
www.concursolutions.com. For example, the URL in the expense report status 
change email might be replaced. Because some URLs can reach 200 characters in 
length, the decision was made to provide the www.concursolutions.com link instead, 
providing a better experience for users. 

NOTE: Even though clients can define URLs that are an acceptable length, the SAP 
Concur system appends additional characters – primarily to satisfy mobile 
requirements – and those extra characters can extend the URL up to 200 
characters.  

The link in the email still works as it always has – redirecting the user for proper SSO 
authentication. The user can see the underlying URL at any time by hovering the 
mouse pointer over the www.concursolutions.com link.  

This change does not affect those emails where the user clicks a button – instead of 
a link – to access Concur Expense.  



Release Notes 

SAP Concur Release Notes Page 14 Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

What the User Sees 

New email look-and-feel: 

 

Configuration / Feature Activation 

This change will occur, over time, automatically; there are no additional 
configuration or activation steps. 

Miscellaneous 

Reminder: No Personal or Sensitive Data in Custom Fields 

Overview 

All companies must take all reasonable steps to protect the personal and sensitive 
information of their employees. Per recommended security-related best practices, 
custom fields should not contain personal or sensitive data. 

! IMPORTANT: Data in custom fields is not encrypted. The client is solely 
responsible for any liability resulting or arising from improper use. 
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Next Steps 

If your company is currently using custom fields to store personal or sensitive data 
(for example, Social Security numbers, family member names, or any other 
personally identifying information), you should plan to remove this information from 
your existing fields within the service and modify your current configuration. 

 For additional information, refer to the FAQ. 

http://www.concurtraining.com/customers/tech_pubs/Security/FAQ_Sensitive_Data_Jan312019.pdf
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Planned Changes 
The items in this section are targeted for future releases. SAP Concur reserves the 
right to postpone implementation of – or completely remove – any 
enhancement/change mentioned here. 

Concur Invoice 

**Planned Changes** New User Interface for Concur Invoice 
Targeted for April Release 

Overview 

SAP Concur will soon offer a new user experience that is particularly targeted at the 
Accounts Payable (AP) user who is constantly monitoring the health of the Invoice 
lifecycle within the system. With a new AP landing page, concepts of "call to action" 
and "work to zero" are being brought to the forefront to better inform AP users to 
ensure they are working on the highest priority task. 

The new user interface in Concur Invoice that clients can now review and familiarize 
themselves with is targeted for general availability the second quarter in 2019.  

NOTE: Contact your SAP Concur representative for more information about the Early 
Access program. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user interface enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 
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What the Invoice AP User and Invoice Processor See 

The Invoice AP User and the Invoice Processor will now land on a new Invoice 
Manager page that provides key information about all active invoices. 

 

On the Invoice Manager tab, the Invoice AP User and Invoice Processor see new 
tiles and new sections including visibility into Active Invoices and My Tasks 
sections. 

The Invoice Processor also sees a newly designed Unassigned Invoices page that 
is more modern and aligns with Next Gen UI initiatives across the SAP Concur Spend 
platform. 
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What the Invoice User Sees 

Invoice users who have access to My Requests, will see a newly designed My 
Invoices page that is more modern and aligns with Next Gen UI initiatives across 
the SAP Concur Spend platform. 

 

Configuration / Feature Activation  

Clients can activate this feature on the Invoice Preferences page by selecting 
(enabling) the Activate check box in the Next Generation Invoice User 
Experience section. 

 

NOTE: More information about the new Concur Invoice user interface will be made 
available in future release notes. 
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**Planned Changes** Payment Request(s) Renamed to Invoice(s) 

Overview 

In a future release, SAP Concur will replace instances of the term "payment request" 
and its iterations with the term "invoice" and its iterations. These changes will be 
made in the user interface, the Concur Invoice documentation, and in all other SAP 
Concur product documentation where it appears. 

NOTE: The term change is targeted for the April release. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change helps to ensure that the terminology used in SAP Concur is consistent 
with industry standard terminology. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

Purchase Order 

**Planned Changes** Import Now for PO and PO Receipt Imports 

Overview 

The Import Now feature enables clients to import PO and PO receipt files into Concur 
Invoice immediately without having to wait for an overnight scheduled import. This is 
beneficial for clients who need to import POs and PO receipts and work with them in 
the Concur Invoice product the same day they are created externally. This also 
allows clients to do multiple PO and PO receipt imports a day for more synchronized 
and up-to-date data. 

NOTE: The Import Now feature is currently in an Early Adopter program. For more 
information, contact your SAP Concur representative. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature gives clients control over when and how frequently to import POs and 
PO receipts into Concur Invoice. 
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Configuration / Feature Activation 

This enhancement is automatically available. To start using this feature, clients need 
to add the suffix "importnow" on their PO and PO receipt files that are transferred to 
their FTP site. 

Current Import Naming Convention 

The current naming conventions are as follows:  

• PO import: poinvoice_EntityID_Date 

• PO Receipt Import: purch_receipt_EntityID_Date 

These naming conventions will remain as is today and the files will continue to be 
picked up and run on the existing schedule. Clients who wish to always import these 
records using the import now option should adjust their schedules accordingly and 
remove any scheduled jobs from the purchase order and purchase order receipt 
import job definitions. 

Import Now Naming Convention 

The Import Now naming conventions are as follows:  

• PO Import: poinvoiceimportnow_EntityID_Date 

• PO Receipt Import: purch_receiptimportnow_EntityID_Date 

For the Import Now option, the PO receipt file is usually dependent on the PO file, so 
clients must coordinate their file transfer to the FTP site so that the PO file is always 
transferred first before the PO receipt file to ensure the PO’s are imported before the 
receipts. The PO receipt Import Now function will not start until any active PO import 
running is completed. However, once the PO files are sent with the "importnow" 
suffix, they will be imported immediately when they are transferred to the FTP site. 

NOTE: Clients must have an FTP site to use this feature. 

Budget 

**Planned Changes** Workflows for Budget 

Overview 

In a future release, workflows will be available for Budget. Workflows define how the 
system routes invoices, expense reports, and requests through approval and 
processing steps. The flexible workflow feature for Budget that SAP Concur offers 
allows companies to design workflows specifically tailored to their unique needs.    
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Without budget review, budgets may become fully consumed well before the end of a 
period or year leaving an organization with limited options and budget owners with, 
for example, exceeded budgets. In addition, early spending means spending that is 
more important to the organization will be declined because less important spending 
consumed the budget early on.  

Combining budget review in the workflow adds value. Audit rules and workflow step 
rules can help organizations to add in controls when it makes sense to fine tune to 
an organization's specific needs.  

Equally important is the determination when a spending item is regarded as 
committed toward a budget. In most organizations, the commit is when a spending 
item is paid; it went through most if not all approval steps. In other organizations, 
the commit occurs much earlier. As soon as a purchase request or an authorization 
request is approved it is regarded as "promised".    

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature will provide clients with control over the budget spend to, for example, 
avoid exceeded budgets too early in a budget period or budget year.   

Configuration / Feature Activation 

The administrator must configure this feature on the Approval Routing page. 

 To access the Approval Routing page: 

1. Click Administration > Invoice Settings or Expense Settings or Expense 
& Invoice Settings. 

2. In the Product list, click Invoice or Expense depending on the product you 
are working with. 

3. In the Policy section, click Show Advanced Settings. 

4. Click Invoice Approvals, Expense Approvals, or Purchase Request 
Approvals. 

Security 

**Planned Changes** No Future Bulk Password Resets or Updates 
via Import File 

Overview 

In a future release, the ability to reset or update user passwords through the User 
Import and Employee Import features, will be removed. The ability to set the 
password for new users during the initial import through the User Import and 
Employee import features will still be available. 
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NOTE: At this time, SAP Concur plans on providing a bulk password reset tool in the 
future. 

USER IMPORT 

The password field will remain available in the downloadable Excel template, but will 
only be read during an initial import of the file, or when creating a new user in the 
system. Subsequent uses of the field will be ignored by the system. 

 For general information about this functionality, refer to the Shared: User 
Import User Guide. 

EMPLOYEE IMPORT 

The password fields will remain available in the 100, 300, 305, and 310 records sets, 
but will only be read during an initial import of the file, or when creating a new user 
in the system. Subsequent uses of the field will be ignored by the system. The 
update and replace password features on the 100 record will no longer be used. 

 For general information about this functionality, refer to the Shared: 
Employee Import Specification. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change provides greater security for user passwords. 

Configuration / Feature Activation 

These changes occur automatically; there will be no configuration or activation steps. 

Company Administration 

**Planned Changes** Composite Logins to be Deprecated 

Overview 

In a future release, SAP Concur will no longer support composite login sign-in page 
URLs.  

Composite login functionality allows users to use a login ID that does not include a 
domain to log in to SAP Concur products. The typical URL for a composite login page 
includes the name of the entity (for example, entity=pxxxxxxxxx) and is formatted 
as follows: https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx. 

After this change is implemented, all users who use only their username to log in will 
need to use their CTE Login Name rather than their login ID to log in to SAP Concur 
products. 

https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx
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In addition, all clients will use the standard Sign In page to access SAP Concur 
products. The standard sign in page is located at the following address: 
https://www.concursolutions.com/nui/signin 

Deprecation of the composite login pages for www.concursolutions.com is targeted 
for May 11, 2019. 

IMPACTS TO USERS 

Users who log in to a composite login page 
(https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx) and do not use 
an at (@) symbol in their user name must contact their company administrator to 
get their CTE Login Name. User passwords will remain the same. 

Single Sign-On functionality is not impacted by this change. The following users will 
not be impacted because they do not log in using https://www.concursolutions.com: 

• SAP Concur web SSO 

• Concur Mobile username/password 

• Concur Mobile SSO 

BUSINESS PURPOSE / CLIENT BENEFIT 

Deprecating this feature improves login stability and login success rates, while 
reducing login dependency. 

What the User Sees 

Users are currently seeing a message on composite login pages about the planned 
deprecation. 

All users who use only their username (ex: johndoe) to log in will need to use their 
CTE Login Name rather than their login ID to log in to SAP Concur products. 

https://www.concursolutions.com/nui/signin
http://www.concursolutions.com/
https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx
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BEFORE 

 

AFTER 
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What the Admin Sees 

On the User Administration page, under General Settings, admins will see the 
CTE Login Name for each user. 

 

NOTE: For future employee imports, include the domain name for users who 
previously did not have a domain name in the Concur Expense database. 

Configuration / Feature Activation 

This change occurs automatically; there are no additional configuration or activation 
steps. 

**Planned Changes** Single Sign-On (SSO) Self-Service Option 
Coming to SAP Concur 

Overview 

Single Sign-On allows users to access multiple applications using one set of login 
credentials. Currently, SAP Concur has two methods for signing in: with a user name 
and password or using SSO with identity provider (IdP) credentials, such as a user's 
login credentials for their organization. 

SAP Concur is planning to add a Manage Single Sign-On (SSO) feature to SAP Concur 
which provides SAP Concur clients with a self-service option for setting up SSO for 
their organization. SSO is currently supported for Concur Expense, Concur Invoice, 
Concur Request, and Concur Travel. 

Other SAP Concur products and services are outside the scope of this initial release. 

The new Manage Single Sign-On (SSO) feature will be accessible from the 
Administration > Company > Company Admin page. 



Planned Changes 

SAP Concur Release Notes Page 26 Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

NOTE: This new feature does not affect Concur Travel clients who are already using 
the Security Keys feature. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides SAP Concur clients with a self-service option for setting up 
SSO. 

Configuration / Feature Activation 

Configuration information will be coming in a future release note. 

**Planned Changes** New SAP Concur Sign In Page 

Overview 

SAP Concur is planning to add a new Sign In page, providing an updated login 
experience for users who log in with user name and password credentials. Current 
Single Sign-On (SSO) users will be able to start the SSO login process at 
www.concursolutions.com. This feature is planned for 2019. 

The new Sign In page feature includes the following: 

• Two-step login: provides enhanced security, meets current industry 
standards, and provides a better log in success rate 

• Multi-account login: allows administrators to log in with multiple accounts 
(planned for a future release) 

• User avatar: enhances the user experience (planned for a future release) 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides better security and a faster, more convenient experience for 
users logging in to SAP Concur products and services. 
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What the User Sees – Current Sign In Page 

The SAP Concur Sign In page currently appears with User Name and Password 
fields, and a Sign In button. Once a user is authenticated, the SAP Concur Home 
page appears. 
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What the User Sees – New Sign In Page 

The new SAP Concur Sign In page will have an Email or Username field and a 
Continue button. The user will type in their email or username. The user can select 
the Remember me on this computer check box, so their email or username is 
stored and will not have to be reentered the next time they log in to SAP Concur.  

After entering their email or username, the user will then click Continue. 

 

Depending on the client’s implementation of SAP Concur, users will then be directed 
to the designated Identity Provider (IdP) Single Sign-On portal or an additional Sign 
In page. 
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SSO USERS 

When the designated Identity Provider (IdP) Single Sign-On portal appears (similar 
to the one shown below), the user will enter their email or username, and their 
password, and then click Sign In. After being authenticated, the user will be 
directed to the SAP Concur Home page. 

 

After being authenticated, the user will be directed to the SAP Concur Home page. 
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USERS WITH USERNAMES AND PASSWORDS 

The user will be directed to an additional Sign In page. The user will enter a 
password and click Sign In. The system will then authenticate the user's credentials. 

 

Once the user’s password is verified, the SAP Concur Home page appears. 

RETURN USERS 

If a returning user selected the Remember me on this computer check box during 
their initial login session, they will see their email or user name displayed on the 
Sign In page. Users who did not select the Remember me on this computer 
check box will log in as they did initially. 
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The user will click on their username, and then and then one of the following occurs: 

• SSO Users: The user will be directed to the SAP Concur Home page. 

• Users with Usernames and Passwords: On the Sign In page, the user 
will enter a password and then click Sign In. The user will then be directed to 
the SAP Concur Home page. 

USERS WITH MULTIPLE ACCOUNTS 

SAP Concur users with multiple login accounts have more than one login option 
depending on the user role or account they want to use. The user will first log in to 
SAP Concur using one of their accounts. Once successfully logged in, the user logs 
out of the system. 

To add another account, on the Sign In page, the user clicks the Use Another 
Account link. 

 

The next login step depends on the account type the user wishes to use: 

• SSO Account: If the user selects an account with SSO credentials, the user 
will enter an email, then the user will be directed to the IdP Single Sign-On 
portal. Once the user is authenticated, the SAP Concur Home page appears. 

• Username and Password: The user is directed to an additional Sign In 
page to enter a password. The user then clicks Sign In. Once the user is 
authenticated, the SAP Concur Home page appears. 
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When all of the accounts have been added, a return user will select the account they 
want to use to log in to SAP Concur. 

 

FORGOT USER NAME 

If a user forgets their user name, the user will click the Forgot username? link on 
the Sign In page.  
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Next, the Forgot User Name page appears. On the Forgot User Name page, the 
user will enter their email and click Send to have an email sent to a verified email 
account. The email will contain their user name. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 
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INVALID PASSWORD 

If a user forgets their password, an on-screen message will appear alerting the user. 
The user will then click Send to have a password reset email sent to their verified 
email account. 

SAP Concur compares the email address entered by the user to the email address in 
the user's SAP Concur profile. If the email addresses match, then SAP Concur 
generates a one-time sign-in token (link) that can be used for one hour. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 

 

Configuration / Feature Activation 

Configuration information will be provided in a future release note. 

**Planned Changes** New Forgot Password Page and Related 
Feature Deprecation 

Overview 

SAP Concur will add a new Forgot Password feature to the SAP Concur Sign In page, 
providing an updated login experience for users who log in with user name and 
password credentials. 

When the new Forgot Password feature is released (targeted for May 11th), the 
following existing Forgot Password page functionality will be deprecated: 

• Security Questions: Users will no longer receive security question prompts 
for login authentication. 



Planned Changes 

SAP Concur Release Notes Page 37 Invoice Professional/Premium 
Release Date: March 16, 2019  SAP Concur Client FINAL 
Update 1: Wednesday, April 3, 12:00 PM PST 
 

• On-page text: Company custom text will no longer be displayed. 

• Password hints: The option, Send me an email with my password hint, 
will no longer be available. 

NOTE: SAP Concur currently plans to release the Forgot Password feature in advance 
of the planned New SAP Concur Sign In page. For more information, refer to 
the **Planned Changes** New SAP Concur Sign In Page release note in this 
document. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides greater security for user passwords and streamlines the user 
experience. 

What the User Sees – Current Forgot Password Page 

When a user enters an incorrect password on the SAP Concur Sign In page 
(www.concursolutions.com) and clicks the Forgot Password? link, a Forgot 
Password page displays. This page has options for the user to have an email sent to 
a verified account that includes a password hint or a link to reset the password. 
Some companies also have custom text that displays on this page. 

 

http://www.concursolutions.com/
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What the User Sees – New Forgot Password Page 

When a user enters an incorrect password on the SAP Concur Sign In page 
(www.concursolutions.com) and clicks the Forgot Password? link, a new Forgot 
Password page will display. The user will enter their user name and click Submit. A 
reset password notification email will then be sent to the user's verified email 
account. 

 

http://www.concursolutions.com/
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The user will open the reset password notification email, which includes a one-time 
reset password link that is valid for 24 hours. The user will click the Reset Your 
Password icon in the email. 
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The Password Reset page opens in the user's browser. 

 

The user will see the company's password policy display on the page. The user will 
enter a new password in the New Password and Re-enter New Password fields. 
If the passwords do not match, an on-page message alerts the user. 

The user can also click on the Password Help Info icon to view a hint to make the 
password stronger. 

The user then clicks the Submit button to create the new password. 
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Once the password is validated, the user will see a message confirming that the new 
password has been successfully created. 

 

The user will click OK. The user will be directed to www.concursolutions.com to log in 
with the new password. 

http://www.concursolutions.com/
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FAILED PASSWORDS 

If the new password fails validation, the Password Reset page will display errors to 
help the user create a password that meets their company requirements. 

 

Configuration / Feature Activation / Feature Deprecation 

Additional information will be provided in a future version of the release notes. 

Training Administration  

**Planned Changes** Optimizing and Relocating the Page 

Overview 

To simplify the Training Administration page, the functionality and content will be 
changing. 

In addition to content changes, access to the Training Administration page will 
move from Company Admin to Tools. 

BUSINESS PURPOSE / CLIENT BENEFIT 

These changes will make the Training Administration feature easier to find and use. 
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Configuration / Feature Activation 

The changes will be automatically available; additional information about potential 
configuration or activation steps will be provided in a later version of these release 
notes. 

 For general information about the Training Administration feature, refer to 
the Shared: Training Administration Setup Guide. 

Test User Admin 

**Planned Changes** Retiring the Purge Test User Transactions 
Functionality 

Overview 

SAP Concur is retiring the functionality in the Test User Admin feature that removes 
the transactions of test users from Concur Expense, Concur Invoice, Concur Travel, 
and Concur Request.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will allow SAP Concur to devote more resources to development and 
maintenance of features that are used by many or most of our clients. 

What the Admin Sees  

The Test User Admin page will no longer display the Purge Test User 
Transactions button. 

Before 
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NOTE: To access the page, click Administration > Expense (or Invoice or 
Requests) > Test User Admin. 

After 

  

Configuration / Feature Activation 

The functionality will automatically be removed. 

 For general information about the Test User Admin feature, refer to 
the Shared: Test User Setup Guide. 
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Client Notifications 

Subprocessors 

SAP Concur Non-Affiliated Subprocessors 

The list of non-affiliated subprocessors is available here: SAP Concur list of 
Subprocessors 

If you have questions or comments, please reach out to: Privacy-
Request@Concur.com  

Browser Certifications 

Monthly Browser Certifications and Supported Configurations 

The SAP Concur Release Notes – Monthly Browser Certifications document lists 
current and planned browser certifications. The document is available with the other 
SAP Concur monthly release notes. 

 For information about accessing all release notes, browser certifications, 
setup guides, user guides, other technical documentation, and supported 
configurations, refer to the Additional Release Notes and Other Technical 
Documentation section in this document. 

https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
mailto:Privacy-Request@Concur.com
mailto:Privacy-Request@Concur.com
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SAP Concur Support Case Status 
This release might resolve previously submitted support cases. You can check the 
status of a support case to confirm whether the case issue has been resolved. 

Check Support Case Status 

The steps in this procedure provide instructions for checking whether a case is 
resolved. 

 To check the status of a submitted case: 

1. Log on to https://concursolutions.com/portal.asp. 

2. Click Help > Contact Support.  

  

The SAP Concur support page displays. 

 

https://concursolutions.com/portal.asp
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If the Contact Support option is not available in the Help menu, then your 
company has chosen to support the SAP Concur system internally. Please 
contact your internal support desk for assistance. 

3. In the Quick Search field, enter your Case ID. 

4. Click Search. Search results are limited to each company's own cases. 

March Example 

The table below contains some example cases that are resolved in this release. It is 
not a comprehensive list of the resolved cases. 

NOTE: The contents of this table are intended for SAP Concur employees only; do 
not distribute this information outside of SAP Concur.  

 
Case ID CRMC # Defect # Description Client 

13220210 CRMC-130630 EXP-27176 

List Management 
In List Management, some 
numerical item codes that 
contained a dot were 
incorrectly rounded up or 
down. 

Eversheds 

Sutherland 
(International) 
LLP 

13303301 

13290435 
CRMC-130450 
CRMC-130285 INV-31554 

Auditing 
An audit rule that was 
configured to run when an 
invoice was submitted, was 
incorrectly triggered by a 
different event. 

Chemical 
Financial 
Corp., 

Nihon Unisys, 
LTD. 

13243690 CRMC-130007 INV-31577 

Invoice Approval 
Invoice Approvers received 
"Unexpected System Error" 
messages and experienced 
slow performance in Concur 
Invoice. 

PetVet Care 
Centers 

13210613 CRMC-130000 INV-31454 

Capture Processing 
On the Email Administration 
tab, in some cases, when the 
Alias Name was updated, the 
change was not saved. 

The Kellen 

Company 

12955001 CRMC-129650 INV-31643 

Expense Types 

The Tax Code was not 
updated when the Expense 
Type was changed in an 
invoice line item. 

DAIWA 
LIFENEXT 
CO., LTD. 
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Additional Release Notes and Other Technical 
Documentation 

Online Help – Admins 

A user who is assigned an admin role can access release notes, setup guides, user 
guides, admin summaries, monthly browser certifications, supported configurations, 
and other resources through Invoice Administration Help. 
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SAP Concur Support Portal – Selected Users 

Users who are assigned the correct SAP Concur support portal permissions can 
access release notes, setup guides, user guides, admin summaries, monthly browser 
certifications, supported configurations, and other resources through the SAP Concur 
support portal. 

 To access the SAP Concur support portal (for users with the correct 
permissions): 

1. Click Help > Contact Support.  

2. On the support page, click Resources > Release/Tech Info. 
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© 2019 SAP SE or an SAP affiliate company. All rights 
reserved. 

No part of this publication may be reproduced or transmitted in any form or for any 
purpose without the express permission of SAP SE or an SAP affiliate company.  

SAP and other SAP products and services mentioned herein as well as their 
respective logos are trademarks or registered trademarks of SAP SE (or an SAP 
affiliate company) in Germany and other countries. Please see 
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional 
trademark information and notices.  

Some software products marketed by SAP SE and its distributors contain proprietary 
software components of other software vendors.  

National product specifications may vary.  

These materials are provided by SAP SE or an SAP affiliate company for 
informational purposes only, without representation or warranty of any kind, and 
SAP SE or its affiliated companies shall not be liable for errors or omissions with 
respect to the materials. The only warranties for SAP SE or SAP affiliate company 
products and services are those that are set forth in the express warranty 
statements accompanying such products and services, if any. Nothing herein should 
be construed as constituting an additional warranty.  

In particular, SAP SE or its affiliated companies have no obligation to pursue any 
course of business outlined in this document or any related presentation, or to 
develop or release any functionality mentioned therein. This document, or any 
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible 
future developments, products, and/or platform directions and functionality are all 
subject to change and may be changed by SAP SE or its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise, or legal obligation to deliver any material, code, or 
functionality. All forward-looking statements are subject to various risks and 
uncertainties that could cause actual results to differ materially from expectations. 
Readers are cautioned not to place undue reliance on these forward-looking 
statements, which speak only as of their dates, and they should not be relied upon in 
making purchasing decisions. 
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Legal Disclaimer 
The information in this presentation is confidential and proprietary to SAP SE or an 
SAP affiliate company and may not be disclosed without the permission of SAP SE or 
the respective SAP affiliate company. This presentation is not subject to your license 
agreement or any other service or subscription agreement with SAP SE or its 
affiliated companies. SAP SE and its affiliated companies have no obligation to 
pursue any course of business outlined in this document or any related presentation, 
or to develop or release any functionality mentioned therein. This document, or any 
related presentation and SAP SE or an SAP affiliate company’s strategy and possible 
future developments, products and or platforms directions and functionality are all 
subject to change and may be changed by SAP SE and its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise or legal obligation to deliver any material, code or 
functionality. This document is provided without a warranty of any kind, either 
express or implied, including but not limited to, the implied warranties of 
merchantability, fitness for a particular purpose, or non-infringement. This document 
is for informational purposes and may not be incorporated into a contract. SAP SE 
and its affiliated companies assume no responsibility for errors or omissions in this 
document, except if such damages were caused by SAP SE or an SAP affiliate 
company’s willful misconduct or gross negligence.  

All forward-looking statements are subject to various risks and uncertainties that 
could cause actual results to differ materially from expectations. Readers are 
cautioned not to place undue reliance on these forward-looking statements, which 
speak only as of their dates, and they should not be relied upon in making 
purchasing decisions. 
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Release Notes 
This document contains the release notes for Concur Invoice functionality for 
professional edition. 

Concur Invoice 

New User Experience Enhancements for Concur Invoice  

Overview 

SAP Concur now offers a new user experience that is particularly targeted at the 
Accounts Payable (AP) user who is constantly monitoring the health of the Invoice 
lifecycle within the system. With a new AP landing page, concepts of "call to action" 
and "work to zero" are being brought to the forefront to better inform AP users to 
ensure they are working on the highest priority task. 

The new landing page, Invoice Manager, contains links to important tasks the AP 
user needs to perform daily, such as assign and submit invoices. The Invoice 
Manager page is also available for the Invoice Processor with links similar to the AP 
user. The following image shows all the options available on the page if you have 
several roles. This means that the Invoice Manager page will differ depending on 
the role the user has. 

 

NOTE: SAP Concur has utilized existing group and policy configuration in the legacy 
user interface when displaying counts and cards on the new Invoice 
Manager page to ensure clients continue to see only what they are supposed 
to. 
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Another new page, Unassigned Invoices, appears when AP users click on the 
Unassigned Invoices link on the Invoice Manager page. 

 

In addition, Concur Invoice has added a new My Invoices page, which is accessed 
by clicking My Tasks > Unsubmitted Invoices or All My Invoices from the 
Invoice Manager page. 

NOTE: Non-AP users are directed to the My Invoices page when they click the 
Invoice tab. The Invoice Manager page is not accessible to them. 

 

The first time a user logs in to Concur Invoice, they will see a Welcome back! 
window with information about the new user experience. Users can click the Learn 
More button to read more about the new user experience. This window will only 
appear once for a user and will be removed from the product in the near future.  
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BUSINESS PURPOSE / CLIENT BENEFIT 

The new Concur Invoice user experience enables clients to work more efficiently and 
provides them greater visibility into their invoices in flight. 

Term Changes 

With the new user experience, several terms have changed name. These terms are 
listed in the table below. 
 
Previous Term New Term 

Request ID Invoice ID 

Request Name Invoice Name 

Payment request or Payment Request Invoice 

Payment Request Type Policy 

NOTE: At this point, imports, extracts, and any customizations performed by clients 
are not included in the term change. In addition, the term Request Key will 
not change either. 
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What the Invoice AP User Sees 

The Invoice AP User will see a new Invoice Manager page when they click on the 
Invoice tab. 

 

NOTE: The Sent to Purchasing link will only display if the user also has the Invoice 
Purchasing User role and the Unverified Capture link will only display if the 
user has the Client managed Capture Verifier role. 

In addition, they will see a new Unassigned Invoices page. 

 

The My Request page has been redesigned and renamed to the My Invoices page. 
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What the Invoices Processor and Invoice Processor (Audit) See 

The Invoice Processor will see a new Invoice Manager page when clicking the 
Invoice tab. 

 

NOTE: The Unapproved Vendors link will only display if the user also has the 
Invoice Vendor Manager role. 

What the Invoice Configuration Administrator Sees 

Apart from seeing everything that the AP user and Invoice Processor see, the user 
with the Invoice Configuration Administrator role will also see an Edit Company 
Dashboard button in Invoice Manager. 
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When they click this button, the tiles in the Active Invoices section will display an 
editing icon. 

 

Clicking the editing icon, the Invoice Configuration Administrator will see an 
Unassigned Invoices window where they can define how long an invoice should be 
unassigned before showing the user an alert.  

 

Once the Invoice Configuration Administrator has finished editing and clicked Save, 
they are returned to the Invoice Manager page and can click the Finish Editing 
button. 

What the Invoice User Sees 

Concur Invoice users who have access to the My Requests page will see a newly 
designed My Invoices page that is more modern and aligns with Next Gen UI 
initiatives across the SAP Concur Spend platform. Many of the items in the Actions 
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menu are now buttons, one for each action, and images are more easily accessible in 
their own Image column. 

 

Configuration / Feature Activation  

This feature is automatically available; no configuration or activation is required. 

 For more information, refer to the Concur Invoice Accounts Payable User 
Experience Enhancement Client Fact Sheet. 

Purchase Request 

Vendor Field in PR Line Item Defaults to Previously Selected 
Vendor 

Overview 

When line items are added to a new or existing purchase request on the Purchase 
Details page, after the first line item is added, the Vendor field for subsequent line 
items defaults to the previous selected vendor. 

Prior to this change, the vendor had to be manually selected each time a new 
purchase request line item was added. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change reduces the number of steps required to add subsequent line items, to a 
purchase request making the process of creating and updating purchase requests 
more efficient and less time consuming. 

What the Purchase Request User Sees 

On the Purchase Details page, after adding the first line item to a purchase 
request, when subsequent line items are added, the user sees the previously 
selected vendor name in the Vendor field.  
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Configuration / Feature Activation 

The update is automatically available; there are no additional configuration or 
activation steps. 

Payment Manager 

Payment Confirmation Extract Available Without Invoice Pay 

Overview 

With this release, payment managers will be able to use the Payment Confirmation 
Extract without Invoice Pay being enabled. This is helpful for Concur Invoice provider 
pay users so that they can export provider payment information together with SAP 
Concur payment data. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature enables clients, who use the payment provider, to download payment 
confirmation extract data to reconcile their ERP. 

What the Payment Manager Sees 

Payment managers will see the Payment Confirmation Extract link in the Extract 
section of the Payment Manager. 

 

Configuration / Feature Activation 

The update is automatically available; there are no additional configuration or 
activation steps. 
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Invoice Pay 

Updated Direct Debit Request Form (Australia) 

Overview 

The Direct Debit Request form for Invoice Pay clients in Australia has been updated 
to more accurately reflect the name of the service agreement. The text that was in 
the Service Agreement field of the form is "Concur Business Service Agreement 
(BSA) and Service Description Guide (SDG)" and the current text is "Agreement for 
the SAP Concur Service." 

NOTE: Other minor changes have been made to this form, such as updating our 
company logo. 

BUSINESS PURPOSE / CLIENT BENEFIT 

The new text more accurately covers the various SAP Concur client contracts. 

What the Admin Sees  

Clients cannot directly access this form, but when it is provided to them, they will 
see an updated Service Agreement name. 

Budget 

Workflows for Budget Now Available 

Overview 

Workflows are now available for Budget. Workflows define how the system routes 
invoices, expense reports, and requests through approval and processing steps. The 
flexible workflow feature for Budget that SAP Concur offers allows companies to 
design workflows specifically tailored to their unique needs.   

Without budget review, budgets may become fully consumed well before the end of a 
period or year leaving an organization with limited options and budget owners with, 
for example, exceeded budgets. In addition, early spending means that more 
important (to the organization) spending will be declined because lesser important 
spending consumed the budget early on.  

Combining budget review in the workflow adds value. Audit rules and workflow step 
rules can help organizations to add in controls when it makes sense to fine tune to 
an organization's specific needs.  

Equally important is the determination when a spending item is regarded as 
committed toward a budget. In most organizations, the commit is when a spending 
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item is paid; it went through most if not all approval steps. In other organizations, 
the commit occurs much earlier. As soon as a purchase request or an authorization 
request is approved it is regarded as committed.   

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature will provide clients with control over the budget spend to, for example, 
avoid exceeded budgets too early in a budget period or budget year.   

IMPORTANT TO NOTE 

Clients should note the following: 

• If clients are using the old Concur Expense user interface, the budget 
approval step does not display the budget approver on the mobile app until 
after the step in the workflow. This also means that the budget approval step 
does not work if clients use the mobile app to approve expense reports that 
include budget.  

• Japanese clients who use e-Bunsho and China Data Center clients must use 
the old Concur Expense UI. Thus, SAP Concur recommends that these clients 
do not approve budgets on the mobile app. 

• The approval flow windows on mobile, available for Concur Invoice only, do 
not display the budget approver until after the budget approval step is 
completed. However, this does not prevent anyone from approving invoices 
for Budget. 

What the Admin Sees 

The admin will see the new Budget Approval step available in the Workflows tool. 
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In addition, they will see a new Manage Approvers (Optional) tab in the Add 
Budget Item and Modify Budget Item windows in Budget Items. 

 

NOTE: There is a limit of five budget approvers per budget item. 

What the Approver Sees 

The approver will see the budget approvers in the Approval Flow window. The 
window displays budgets that are approved, auto approved, and not approved. 

NOTE: Concur Expense and purchase request on mobile do not have the approval 
flow windows. 
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Configuration / Feature Activation 

The administrator needs to configure this feature on the Workflows page by clicking 
Administration > Invoice or Expense. 

 For more information, refer to the Concur Budget Workflow Client Fact Sheet. 

SAP Concur Email 

**Ongoing** Email Infrastructure Change - Add IP Addresses to 
Safe Senders List 

Overview 

SAP Concur is transitioning to a new email infrastructure for outbound email from 
our services to SAP Concur users. Because of this, companies that filter inbound 
email based on the sending IP address must add new IP addresses to their Safe 
Senders list to ensure that their users receive email from SAP Concur. 
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IMPORTANT: All Services Will Soon Be Affected 

Initially, the issue described here affected only companies that use Concur Expense. 
Starting in January, email from other SAP Concur services (such as Concur Travel 
and Concur Pay) will move to the new email infrastructure.  

We will continue to add other service. Please monitor the release notes for more 
information about the timing of the additional changes. 

NOTE: This change only affects companies that filter incoming email based on IP 
addresses. 

Configuration / Feature Activation 

The new IP addresses are not published publicly but they are available by contacting 
SAP Concur support. If your company uses Concur Expense and if your company 
filters incoming email based on IP address, please work with your email server 
management team to ensure that all required IP address Safe Senders lists are 
updated so that your users continue to receive SAP Concur email without 
interruption. 

Miscellaneous 

Reminder: No Personal or Sensitive Data in Custom Fields 

Overview 

All companies must take all reasonable steps to protect the personal and sensitive 
information of their employees. Per recommended security-related best practices, 
custom fields should not contain personal or sensitive data. 

! IMPORTANT: Data in custom fields is not encrypted. The client is solely 
responsible for any liability resulting or arising from improper use. 

Next Steps 

If your company is currently using custom fields to store personal or sensitive data 
(for example, Social Security numbers, family member names, or any other 
personally identifying information), you should plan to remove this information from 
your existing fields within the service and modify your current configuration. 

 For additional information, refer to the FAQ. 

http://www.concurtraining.com/customers/tech_pubs/Security/FAQ_Sensitive_Data_Jan312019.pdf
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Planned Changes 
The items in this section are targeted for future releases. SAP Concur reserves the 
right to postpone implementation of – or completely remove – any 
enhancement/change mentioned here. 

Purchase Order 

**Planned Changes** Import Now for PO and PO Receipt Imports 

Overview 

The Import Now feature enables clients to import PO and PO receipt files into Concur 
Invoice immediately without having to wait for an overnight scheduled import. This is 
beneficial for clients who need to import POs and PO receipts and work with them in 
the Concur Invoice product the same day they are created externally. This also 
allows clients to do multiple PO and PO receipt imports a day for more synchronized 
and up-to-date data. 

NOTE: The Import Now feature is currently in an Early Adopter program. For more 
information, contact your SAP Concur representative. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature gives clients control over when and how frequently to import POs and 
PO receipts into Concur Invoice. 

Configuration / Feature Activation 

This enhancement is automatically available. To start using this feature, clients need 
to add the suffix "importnow" on their PO and PO receipt files that are transferred to 
their FTP site. 

Current Import Naming Convention 

The current naming conventions are as follows:  

• PO import: poinvoice_EntityID_Date 

• PO Receipt Import: purch_receipt_EntityID_Date 

These naming conventions will remain as is today and the files will continue to be 
picked up and run on the existing schedule. Clients who wish to always import these 
records using the import now option should adjust their schedules accordingly and 
remove any scheduled jobs from the purchase order and purchase order receipt 
import job definitions. 
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Import Now Naming Convention 

The Import Now naming conventions are as follows:  

• PO Import: poinvoiceimportnow_EntityID_Date 

• PO Receipt Import: purch_receiptimportnow_EntityID_Date 

For the Import Now option, the PO receipt file is usually dependent on the PO file, so 
clients must coordinate their file transfer to the FTP site so that the PO file is always 
transferred first before the PO receipt file to ensure the PO’s are imported before the 
receipts. The PO receipt Import Now function will not start until any active PO import 
running is completed. However, once the PO files are sent with the "importnow" 
suffix, they will be imported immediately when they are transferred to the FTP site. 

NOTE: Clients must have an FTP site to use this feature. 

Authentication 

**Planned Changes** No Future Bulk Password Resets or Updates 
via Import File 

These changes are part of the SAP Concur continued commitment to maintaining 
secure authentication. 

Overview 

In a future release, the ability to reset or update user passwords through the User 
Import and Employee Import features, will be removed. The ability to set the 
password for new users during the initial import through the User Import and 
Employee import features will still be available. 

USER IMPORT 

The password field will remain available in the downloadable Excel template, but will 
only be read during an initial import of the file, or when creating a new user in the 
system. Subsequent uses of the field will be ignored by the system. 

 For general information about this functionality, refer to the Shared: User 
Import User Guide. 

EMPLOYEE IMPORT 

The password fields will remain available in the 100, 300, 305, and 310 records sets, 
but will only be read during an initial import of the file, or when creating a new user 
in the system. Subsequent uses of the field will be ignored by the system. The 
update and replace password features on the 100 record will no longer be used. 
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 For general information about this functionality, refer to the Shared: 
Employee Import Specification. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change provides greater security for user passwords. 

Configuration / Feature Activation 

These changes occur automatically; there will be no configuration or activation steps. 

**Planned Changes** Composite Logins to be Deprecated 

These changes are part of the SAP Concur continued commitment to maintaining 
secure authentication. 

Overview 

In a future release, SAP Concur will no longer support composite login sign-in page 
URLs. 

Composite login functionality allows users to use a login ID that does not include a 
domain to log in to SAP Concur products. 

All users who use only their username (ex: johndoe) to log in will need to use their 
CTE Login Name rather than their login ID to log in to SAP Concur products. 

NOTE: The CTE Login Name mentioned here is the login name that appears in the 
CTE Login Name field in Administration > Company > Company 
Administration > User Administration. 

SAP Concur will no longer support composite login sign-in page URLs. The typical 
URL for a composite login page includes the name of the entity (ex: 
entity=pxxxxxxxxx) and looks like this: 
https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx. 

All clients will be using the standard Sign In page to access SAP Concur products. 
The standard sign in page is https://www.concursolutions.com/nui/signin. 

Deprecation of the composite login pages for www.concursolutions.com is targeted 
for May 11, 2019. 

NOTE: The employee import and other utilizations of composite logins are not yet 
being deprecated and will continue to function as they do currently. Only the 
user-facing portion of composite login is being deprecated at this time. 

https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx
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IMPACTS TO USERS 

Users who log in to a composite login page 
(https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx) and do not use 
the at (@) symbol in their user name will need to click the Forgot your user 
name? link on the Sign In page to retrieve their user name without assistance 
(preferred) or contact their company administrator to get their CTE Login Name. 
User passwords remain the same. 

Single Sign-On functionality is not impacted by this change. The following users will 
not be impacted because they do not log in using https://www.concursolutions.com: 

• SAP Concur web SSO 

• Concur mobile username/password 

• Concur mobile SSO 

BUSINESS PURPOSE / CLIENT BENEFIT 

Deprecating this feature improves login stability and login success rates, while 
reducing login dependency. 

What the User Sees 

Users are currently seeing a message on composite login pages about the planned 
deprecation. 

 

https://www.concursolutions.com/signin.asp?entity=pxxxxxxxxx
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After the composite login feature is deprecated, these users will automatically be 
redirected to the Sign In page, https://www.concursolutions.com/nui/signin, and 
must use their full user name to sign in. User passwords remain the same. 

BEFORE 

The Sign In page when composite logins are supported. 

 

AFTER 

On the new Sign In page, users who do not know their full user name can find it 
using one of the following options: 

• Click the Forgot your user name? link 

• Contact their company administrator 

https://www.concursolutions.com/nui/signin
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Users will be able to retrieve their user name, without assistance, by clicking the 
Forgot your user name? link on the Sign In page.  

 

On the Forgot User Name page, the user will enter a valid email address associated 
with the SAP Concur account, then click the Send E-mail button. 
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If the specified email address is associated with an SAP Concur account, an email will 
be sent to that address with the full user name included (as Login ID). 

 

If the user chooses to contact their company administrator to get their full user 
name or if the Forgot your user name? option was unsuccessful, the company 
administrator can look up the user’s full user name (visible to admins as in the CTE 
Login Name) and provide it to them. 

What the Admin Sees 

On the User Administration page, under General Settings, admins will see the 
CTE Login Name for each user. 

 

NOTE: For future employee imports, include the domain name for users who 
previously did not have a domain name in the Concur Expense database. 

Configuration / Feature Activation 

This change is automatically available; there are no additional configuration or 
activation steps. 

**Planned Changes** Single Sign-On (SSO) Self-Service Option 
Coming to SAP Concur 

These changes are part of the SAP Concur continued commitment to maintaining 
secure authentication. 
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Overview 

Single Sign-On allows users to access multiple applications using one set of login 
credentials. Currently, SAP Concur has two methods for signing in: with a user name 
and password or using SSO with identity provider (IdP) credentials, such as a user's 
login credentials for their organization. 

SAP Concur is planning to add a Manage Single Sign-On (SSO) feature to SAP Concur 
products which provides clients with a self-service option for setting up SSO for their 
organization. SSO is currently supported for Concur Expense, Invoice, Request, and 
Travel. 

The new Manage Single Sign-On (SSO) feature is a replacement tool for clients using 
existing SSO configuration on the Security Keys page and a new tool for clients that 
now want to implement SSO at their organization. Existing SSO configuration on the 
Security Keys page and the new SSO Self-Service tool will both be available until 
everyone has migrated to the new SSO Self-Service tool. 

Other SAP Concur products and services are outside the scope of this initial release. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides SAP Concur clients with a self-service option for setting up 
SSO. 

Configuration / Feature Activation 

Configuration information will be coming in a future release note. 

**Planned Changes** Forgot Password Feature, Security 
Questions, and Password Custom Text  

These changes are part of the SAP Concur continued commitment to maintaining 
secure authentication. 

Overview 

In a future release, SAP Concur will add a new Forgot Password feature to the SAP 
Concur Sign In page, providing an updated experience for users who log in with 
user name and password credentials. 

NOTE: This change does not affect clients that use SSO to log in to SAP Concur. 

Currently, depending on a company's configuration, there might be several other 
options available for the forgotten password process. When the new Forgot Password 
feature becomes available (targeted for May 11), those additional options will be 
removed. The additional options that will be removed are as follows: 

• Security Questions: Users will no longer receive security question prompts 
for login authentication. 
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• On-page text: Company custom text will no longer display. 

• Password hints: The option, Send me an email with my password hint, 
will no longer be available. 

All of these options are described on the following pages. 

NOTE: The new Forgot Password feature is planned for release in advance of the 
planned New SAP Concur Sign In page. For more information, refer to the 
**Planned Changes** New SAP Concur Sign In Page release note in this 
document. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides greater security for user passwords and streamlines the user 
experience. 

What the User Sees – Current Forgot Password Page and Process 

Currently, if a user cannot remember their password and if the user clicks Forgot 
your password? on the SAP Concur Sign In page, the Forgot Password page 
displays.  

Currently, additional options may be available, depending on the company's 
configuration. They are: 

• The user may have an email sent to a verified email account that includes a 
password hint.  

• The company may require the user to answer a set of security questions prior 
to getting an email with a link to reset their password.  

• The company may also have custom text that displays on this page. 



Planned Changes 

SAP Concur Release Notes Page 24 Invoice Professional/Premium 
Release Date: April 13, 2019  SAP Concur Client FINAL 
Update 1: Friday, April 18, 5:00 PM PST 
 

 

What the User Sees – New Forgot Password Page and Process 

With the new feature, if a user cannot remember their password and if the user 
clicks Forgot your password? on the SAP Concur Sign In page, the Forgot 
Password page displays. 

The user has only one option – the user will enter their user name and click Submit. 
If an SAP Concur account is found for the specified user name, a reset password 
email will be sent to the user's associated email address. 
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The user will open the reset password notification email, which includes a one-time 
reset password link that is valid for 24 hours. The user will click Reset Your 
Password in the email. 
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The Password Reset page opens in the user's browser. 

 

The company's password policy displays on the page. The user will enter a new 
password in the New Password and Re-enter New Password fields. If the 
passwords do not match, an on-page message alerts the user. 

The user can also click Password Help Info to view a hint to make passwords 
stronger. 

The user then clicks Submit to create the new password. 
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Once the password is validated, the user will see a message confirming that the new 
password has been successfully created. 

 

The user will click OK. The user will be directed to www.concursolutions.com to log in 
with the new password. 

FAILED PASSWORDS 

If the new password fails validation, the Password Reset page will display errors to 
help the user create a password that meets their company requirements. 
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Feature to be Removed – Password Hint  

Currently, in Profile > Profile Settings > Change Password, the user can create 
a password hint. Then, if the user forgets their password and selects the Send me 
an email with my password hint option on the Forgot Password page, then an 
email that includes the hint will be sent to a verified email account. 

 

When the new Forgot Password feature becomes available, this field will be removed 
from Profile. 

Feature to be Removed – Security Questions 

Currently, depending on the company's configuration, the company may be able to 
configure security questions for users who have forgotten their passwords. If so, the 
Security Question functionality involves three parts: 

• Company admin security question configuration 

• End user security question configuration 

• Security question challenge 
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SECURITY QUESTION CONFIGURATION 

If the company's configuration allows, the Password Administrator page is 
available, which allows the admin to configure the questions. To access the page, the 
admin clicks Administration > Company > Company Admin > Password 
Administrator. 

 

When the new Forgot Password feature becomes available, this section of the page 
will be removed. 

END-USER CONFIGURATION 

Currently, once the admin activates the security questions, the Password Security 
Questions page appears in Profile. It allows users to manage the security questions 
they will answer if they forget their password. To access the page, the user clicks 
Profile > Profile Settings.  
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In the Other Settings section, the user clicks Password Security Questions. 

 

When the new Forgot Password feature becomes available, this page and menu 
option will be removed. 

SECURITY QUESTION CHALLENGE 

Currently, once configuration is complete, end users are challenged by security 
questions before a password reset link is sent out or before a password changed is 
saved.   

 

When the new Forgot Password feature becomes available, this page will be 
removed. 

Feature to be Removed – Custom Text on the Forgot Password Page 

Currently, depending on the company's configuration, the company may be able to 
provide custom text on the Forgot Password page. 
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If the company's configuration allows, the Password Administrator page is 
available, which allows the admin to define the custom text. To access the page, the 
admin clicks Administration > Company > Company Admin > Password 
Administrator. 
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When the new Forgot Password feature becomes available, this section of the page 
will be removed. 

Configuration / Feature Activation / Feature Deprecation 

This feature will be automatically available. There are no configuration steps. 

Company Administration 

**Planned Changes** SAP Concur Product Access Changes 

Overview 

Beginning in a future release (targeted for June), clients will access SAP Concur 
products and services via the following domains: 

• *.concursolutions.com 

• *.concurcdc.cn 

This change is targeted for June 8, 2019. 

Please contact appsec@sap.com for any questions regarding this change. 

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will allow clients to access SAP Concur services in a consistent, secure 
manner. 

Configuration / Feature Activation 

SAP Concur recommends clients migrate to one of the domains at their earliest 
convenience, if they are not already using one of them. 

**Planned Changes** New SAP Concur Sign In Page 

Overview 

SAP Concur is planning to add a new Sign In page, providing an updated login 
experience for users who log in with user name and password credentials. Current 
Single Sign-On (SSO) users will be able to start the SSO login process at 
www.concursolutions.com. This feature is planned for 2019. 

The new Sign In page feature includes the following: 

• Two-step login: provides enhanced security, meets current industry 
standards, and provides a better log in success rate 

mailto:appsec@sap.com
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• Multi-account login: allows administrators to log in with multiple accounts 
(planned for a future release) 

• User avatar: enhances the user experience (planned for a future release) 

BUSINESS PURPOSE / CLIENT BENEFIT 

This feature provides better security and a faster, more convenient experience for 
users logging in to SAP Concur products and services. 

What the User Sees – Current Sign In Page 

The SAP Concur Sign In page currently appears with User Name and Password 
fields, and a Sign In button. Once a user is authenticated, the SAP Concur Home 
page appears. 
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What the User Sees – New Sign In Page 

The new SAP Concur Sign In page will have an Email or Username field and a 
Continue button. The user will type in their email or username. The user can select 
the Remember me on this computer check box, so their email or username is 
stored and will not have to be reentered the next time they log in to SAP Concur.  

After entering their email or username, the user will then click Continue. 

 

Depending on the client’s implementation of SAP Concur, users will then be directed 
to the designated Identity Provider (IdP) Single Sign-On portal or an additional Sign 
In page. 
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SSO USERS 

When the designated Identity Provider (IdP) Single Sign-On portal appears (similar 
to the one shown below), the user will enter their email or username, and their 
password, and then click Sign In. After being authenticated, the user will be 
directed to the SAP Concur Home page. 

 

After being authenticated, the user will be directed to the SAP Concur Home page. 
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USERS WITH USERNAMES AND PASSWORDS 

The user will be directed to an additional Sign In page. The user will enter a 
password and click Sign In. The system will then authenticate the user's credentials. 

 

Once the user’s password is verified, the SAP Concur Home page appears. 

RETURN USERS 

If a returning user selected the Remember me on this computer check box during 
their initial login session, they will see their email or user name displayed on the 
Sign In page. Users who did not select the Remember me on this computer 
check box will log in as they did initially. 
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The user will click on their username, and then and then one of the following occurs: 

• SSO Users: The user will be directed to the SAP Concur Home page. 

• Users with Usernames and Passwords: On the Sign In page, the user 
will enter a password and then click Sign In. The user will then be directed to 
the SAP Concur Home page. 

USERS WITH MULTIPLE ACCOUNTS 

SAP Concur users with multiple login accounts have more than one login option 
depending on the user role or account they want to use. The user will first log in to 
SAP Concur using one of their accounts. Once successfully logged in, the user logs 
out of the system. 

To add another account, on the Sign In page, the user clicks the Use Another 
Account link. 

 

The next login step depends on the account type the user wishes to use: 

• SSO Account: If the user selects an account with SSO credentials, the user 
will enter an email, then the user will be directed to the IdP Single Sign-On 
portal. Once the user is authenticated, the SAP Concur Home page appears. 

• Username and Password: The user is directed to an additional Sign In 
page to enter a password. The user then clicks Sign In. Once the user is 
authenticated, the SAP Concur Home page appears. 
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When all of the accounts have been added, a return user will select the account they 
want to use to log in to SAP Concur. 

 

FORGOT USER NAME 

If a user forgets their user name, the user will click the Forgot username? link on 
the Sign In page.  

 



Planned Changes 

SAP Concur Release Notes Page 39 Invoice Professional/Premium 
Release Date: April 13, 2019  SAP Concur Client FINAL 
Update 1: Friday, April 18, 5:00 PM PST 
 

Next, the Forgot User Name page appears. On the Forgot User Name page, the 
user will enter their email and click Send to have an email sent to a verified email 
account. The email will contain their user name. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 
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INVALID PASSWORD 

If a user forgets their password, an on-screen message will appear alerting the user. 
The user will then click Send to have a password reset email sent to their verified 
email account. 

SAP Concur compares the email address entered by the user to the email address in 
the user's SAP Concur profile. If the email addresses match, then SAP Concur 
generates a one-time sign-in token (link) that can be used for one hour. 
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The user will see an on-screen affirmation indicating that an email was sent to them. 
The user will click Return to Sign In page to return to the Sign In page. 

 

Configuration / Feature Activation 

Configuration information will be provided in a future release note. 

Training Administration  

**Planned Changes** Optimizing and Relocating the Page 

Overview 

To simplify the Training Administration page, the functionality and content will be 
changing. 

In addition to content changes, access to the Training Administration page will 
move from Company Admin to Tools. 
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BUSINESS PURPOSE / CLIENT BENEFIT 

These changes will make the Training Administration feature easier to find and use. 

Configuration / Feature Activation 

The changes will be automatically available; additional information about potential 
configuration or activation steps will be provided in a later version of these release 
notes. 

 For general information about the Training Administration feature, refer to 
the Shared: Training Administration Setup Guide. 

Test User Admin 

**Planned Changes** Retiring the Purge Test User Transactions 
Functionality 

Overview 

SAP Concur is retiring the functionality in the Test User Admin feature that removes 
the transactions of test users from Concur Expense, Concur Invoice, Concur Travel, 
and Concur Request.  

BUSINESS PURPOSE / CLIENT BENEFIT 

This change will allow SAP Concur to devote more resources to development and 
maintenance of features that are used by many or most of our clients. 

What the Admin Sees  

The Test User Admin page will no longer display the Purge Test User 
Transactions button. 
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Before 

 

NOTE: To access the page, click Administration > Expense (or Invoice or Requests) 
> Test User Admin. 

After 

  

Configuration / Feature Activation 

The functionality will automatically be removed. 

 For general information about the Test User Admin feature, refer to 
the Shared: Test User Setup Guide. 
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Client Notifications 

Subprocessors 

SAP Concur Non-Affiliated Subprocessors 

The list of non-affiliated subprocessors is available here: SAP Concur list of 
Subprocessors 

If you have questions or comments, please reach out to: Privacy-
Request@Concur.com  

Browser Certifications 

Monthly Browser Certifications and Supported Configurations 

The SAP Concur Release Notes – Monthly Browser Certifications document lists 
current and planned browser certifications. The document is available with the other 
SAP Concur monthly release notes. 

 For information about accessing all release notes, browser certifications, 
setup guides, user guides, other technical documentation, and supported 
configurations, refer to the Additional Release Notes and Other Technical 
Documentation section in this document. 

https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
https://support.sap.com/content/dam/support/en_us/library/ssp/my-support/subprocessors/concur-subprocessor-for-sap.pdf
mailto:Privacy-Request@Concur.com
mailto:Privacy-Request@Concur.com
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SAP Concur Support Case Status 
This release might resolve previously submitted support cases. You can check the 
status of a support case to confirm whether the case issue has been resolved. 

Check Support Case Status 

The steps in this procedure provide instructions for checking whether a case is 
resolved. 

 To check the status of a submitted case: 

1. Log on to https://concursolutions.com/portal.asp. 

2. Click Help > Contact Support.  

  

The SAP Concur support page displays. 

 

https://concursolutions.com/portal.asp
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If the Contact Support option is not available in the Help menu, then your 
company has chosen to support the SAP Concur system internally. Please 
contact your internal support desk for assistance. 

3. In the Quick Search field, enter your Case ID. 

4. Click Search. Search results are limited to each company's own cases. 

April Example 

The table below contains some example cases that are resolved in this release. It is 
not a comprehensive list of the resolved cases. 

 
Case ID Description 

13229527 

Vendor Manager 
Vendor information page with custom connected list field did not open in Vendor 
Manager. 

13231353 
Invoice Pay 
Request total did not match payment demand total. 

13394522 

Invoice Import 
Purchase order import via API was stopped with a “Waiting for PO” message if the 
supplied PO number did not already exist in Concur Invoice. 

13462486 

Purchase Request 
If PRs were approved in bulk and automatically transmitted, a PR error could have 
caused an incorrect PO to be generated. 

13512492 
Concur Invoice 
Recurring invoices were not created as scheduled. 
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Additional Release Notes and Other Technical 
Documentation 

Online Help – Admins 

A user who is assigned an admin role can access release notes, setup guides, user 
guides, admin summaries, monthly browser certifications, supported configurations, 
and other resources through Invoice Administration Help. 
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SAP Concur Support Portal – Selected Users 

Users who are assigned the correct SAP Concur support portal permissions can 
access release notes, setup guides, user guides, admin summaries, monthly browser 
certifications, supported configurations, and other resources through the SAP Concur 
support portal. 

 To access the SAP Concur support portal (for users with the correct 
permissions): 

1. Click Help > Contact Support.  

2. On the support page, click Resources > Release/Tech Info. 
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© 2019 SAP SE or an SAP affiliate company. All rights 
reserved. 

No part of this publication may be reproduced or transmitted in any form or for any 
purpose without the express permission of SAP SE or an SAP affiliate company.  

SAP and other SAP products and services mentioned herein as well as their 
respective logos are trademarks or registered trademarks of SAP SE (or an SAP 
affiliate company) in Germany and other countries. Please see 
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional 
trademark information and notices.  

Some software products marketed by SAP SE and its distributors contain proprietary 
software components of other software vendors.  

National product specifications may vary.  

These materials are provided by SAP SE or an SAP affiliate company for 
informational purposes only, without representation or warranty of any kind, and 
SAP SE or its affiliated companies shall not be liable for errors or omissions with 
respect to the materials. The only warranties for SAP SE or SAP affiliate company 
products and services are those that are set forth in the express warranty 
statements accompanying such products and services, if any. Nothing herein should 
be construed as constituting an additional warranty.  

In particular, SAP SE or its affiliated companies have no obligation to pursue any 
course of business outlined in this document or any related presentation, or to 
develop or release any functionality mentioned therein. This document, or any 
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible 
future developments, products, and/or platform directions and functionality are all 
subject to change and may be changed by SAP SE or its affiliated companies at any 
time for any reason without notice. The information in this document is not a 
commitment, promise, or legal obligation to deliver any material, code, or 
functionality. All forward-looking statements are subject to various risks and 
uncertainties that could cause actual results to differ materially from expectations. 
Readers are cautioned not to place undue reliance on these forward-looking 
statements, which speak only as of their dates, and they should not be relied upon in 
making purchasing decisions. 
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